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1 Document information

1.1 Target audience for this manual

This manual is giving detailed information on the system capabilities and architecture. It 
supports project and sales engineers in designing the system architecture during acquisition 
and execution phase. Furthermore during operation time of the system all servicing 
personnel in need of detailed knowledge about the system capabilites.

1.2 Version history

1.3 Document function

1.3.1 Used symbols

Safety symbols

Symbols for certain types of information

Document version Valid for SW version Changes to the previous version

BA01291G/00/EN/01.14 3.0.10 Initial version

Symbol Meaning

A0011189-EN

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will 
result in serious or fatal injury.

A0011190-EN

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in serious or fatal injury.

A0011191-EN

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in minor or medium injury.

A0011192-EN

NOTICE!
This symbol contains information on procedures and other facts which do not result 
in personal injury.

Symbol Meaning

A0011193

Tip
Indicates additional information.

A0011195

Reference to page
Refers to the corresponding page number.

 ,  ,  ... Series of steps

A0018373

Result of a sequence of actions

DANGER

WARNING

CAUTION

NOTICE

1. 2.
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Symbols in graphics

1.4 Documentation

1.4.1 Operating instructions

Symbol Meaning

1, 2, 3 ... Item numbers

 ,  ,  ... Series of steps

A, B, C ... Views

A0011187

Hazardous area
Indicates a hazardous area.

A0011188

Indicates a non-hazardous location
Safe area (non-hazardous area)

Document number Instrument Type of Document

BA01288G/00

� Multi Scan NXA83

Operation manual

BA01290G/00 Installation and Maintenance manual

BA01291G/00 Configuration manual

BA01292G/00 DCC Configuration manual

BA01289G/00 OPC Tank Data Server manual

BA01297G/00 Web Client System Operation manual

BA01287G/00 Weights and Measures Additions

BA01296G/00 Redundancy manual

1. 2.

-

.
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2 Basic safety instructions

2.1 Requirements for the personnel

The personnel for installation, commissioning, diagnostics and maintenance must fulfill the 
following requirements: 

� Trained, qualified specialists: must have a relevant qualification for this specific function 
and task

� Are authorized by the plant owner/operator
� Are familiar with federal/national regulations
� Before beginning work, the specialist staff must have read and understood the instructions 

in the Operating Instructions and supplementary documentation as well as in the 
certificates
(depending on the application)

� Following instructions and basic conditions

The operating personnel must fulfill the following requirements:

� Being instructed and authorized according to the requirements of the task by the facility's 
owner operator

� Following the instructions in these Operating Instructions

2.2 IT security

We only provide a warranty if the device is installed and used as described in the Operating 
Instructions. The device is equipped with security mechanisms to protect it against any 
inadvertent changes to the device settings.

IT security measures in line with operators' security standards and designed to provide 
additional protection for the device and device data transfer must be implemented by the 
operators themselves.

Endress+Hauser can be contacted to provide support in performing this task.

2.3 Designated use

2.3.1 Applications

Inventory control

By using Tankvision Multi Scan to monitor the tank level and stored volume of valuable 
liquids remotely, owners or operators of tank farms or terminals for petroleum products and 
chemicals (liquids) can visualize the volume of the stored medium in real time. The data can 
be used to plan the inventory and distribution. The data can also be used to manage tank 
farm operations like pumping or transferring products. Tankvision has its unique concept 
using network technology. Without using proprietary software, the users can visualize and 
manage their valuable liquids stored in the tanks by a web browser. Tankvision Multi Scan 
is a flexible and cost effective solution due to its scalable architecture. The application 
coverage goes from small depots with only a few tanks up to refineries.

Inventory Calculations

Tankvision Multi Scan calculates based on measured variables and tank capacity tables:
� Observed/Gross volumes,
� Net volumes and
� Mass
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of products like
� Hydrocarbons,
� Liquefied gases,
� Asphalt.

They are corrected according to international standards, including API/ASTM tables 5A, 
5B/6, 53A, 53B/54, 23/24, LPG.
This includes temperature corrections at 15 °C, 60 °F and alternative temperatures. 
Additionally, available pumpable volumes and water volume are calculated.

Remote configuration of measuring equipment

Some on-site operations can be avoided using remote configuration of measuring equipment 
during commissioning or maintenance (the availability of this feature may depend on the 
system configuration).

Application areas

� Tank farms in refineries
� Ship loading terminals
� Marketing and distribution terminals
� Pipeline terminals
� Logistic terminals for tanks storing products like crude oils, refined white and black 

products, chemicals, LPG

2.4 Workplace safety

For work on and with the device: 

� Wear the required personal protective equipment according to federal/national 
regulations.

� Switch off the supply voltage before connecting the device.

2.5 Operational safety

Risk of injury! 

� Operate the device in proper technical condition and fail-safe condition only.
� The operator is responsible for interference-free operation of the device.

Conversions to the device
Unauthorized modifications to the device are not permitted and can lead to unforeseeable 
dangers

� If, despite this, modifications are required, consult with Endress+Hauser.

Repair
To ensure continued operational safety and reliability,

� Carry out repairs on the device only if they are expressly permitted.
� Observe federal/national regulations pertaining to repair of an electrical device.
� Use original spare parts and accessories from Endress+Hauser only.

2.6 Product safety

The device is designed to meet state-of-the-art safety requirements, has been tested and left 
thefactory in a condition in which it is safe to operate. The device complies with the 
applicable standards and regulations as listed in the EC declaration of conformity and thus 
complies with the statutory requirements of the EG directives. Endress+Hauser confirms the 
successful testing of the device by affixing to it the CE mark.
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3 Overview

3.1 Tankvision Multi Scan NXA83

The Multi Scan NXA83 is a small integrated tank gauging and tank inventory management 
system utilizing the latest embedded Windows technology.
In addition to being a small tank inventory management system it can also be used as a 
foreign device gateway to higher level DCS and site wide business information systems by 
providing an open interface to older legacy and proprietary protocols and interfaces.

It features:
� Windows XP Embedded operating system
� An optional full graphical LCD display with touchscreen technology
� Up to 8 communication ports configurable as host or field interfaces
� Inventory Calculations
� A wide range of communications protocols
� Fanless and diskless operation
� A maximum of 256 tanks
� OPC Data Access Server
� System health monitoring via watchdog

NXA83_Typical-Connections

1 SAAB TRL2
2 Ethernet (OPC)
3 ENRAF BPM
4 DCS (MODBUS)
5 MODBUS Tank Gauges
6 ENRAF CIU 858
7 WHESSOE 550
8 VAREC MARK/SPACE

3.2 Configurator

The Multi Scan NXA83 is configured using the Tankvision Multi Scan Configurator software.
This software is pre-installed on the D drive of the NXA83 and may be accessed using remote 
control from a networked PC.

1

2

3

4

5

6

7

8
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The database is stored in the Multi Scan NXA83 on an industrial standard flash memory card 
for maximum reliability. It is transferred between the Multi Scan NXA83 and the 
Configurator PC via an Ethernet network connection.
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4 Quick Start

4.1 Configuring the NXA83 using onboard Configurator 
tools

This section gives a quick overview for connecting to the current version of the Multi Scan 
NXA83.

To start the Tankvision Multi Scan Configurator tools:

Connect a cross-over network cable between the PC and the Multi Scan NXA83.

Configure the network settings on the PC to use a fixed IP address of 192.168.1.252.

In case a different IP address was assigned to the Multi Scan the IP address of the PC 
must be in the same range.

Ensure the Multi Scan NXA83 is running.

Start a Remote Desktop Connection on the PC and connect to the NXA83. → ä 10

Close the NXA83 tankgauging screen, to get access to the operating system. → ä 12

Start the Tankvision Multi Scan Configurator software from the shortcut on the 
Windows Desktop.

To upload a database from the Multi Scan NXA83:

Select the New Project item from the File menu.

Enter a project name, leave the other settings as "Multiscan" and "ROOT" and click OK. 
This will load a blank database.

Select the Database Transporter item from the File menu.

Click on the Import Database button. This will proceed to transfer the database from 
the Multi Scan NXA83 to the Configurator. Click OK when complete.

Exit the Database Transporter.

Select Save Project from the File menu.

The database may now be edited using the options in the Communications and 
Configuration menus.

To download a modified database to the Multi Scan NXA83:

Ensure network connections are as previously configured.

Select Save Project from the File menu.

Select the Database Transporter item from the File menu.

Click on the Export Database button. This will proceed to transfer the database to the 
Multi Scan NXA83 from the Configurator.

Click OK to the message confirming the export.

Exit the Database Transporter.

Exit the Configurator software.

Carry out a Commit using the desktop shortcut, to reboot the NXA83 and save all data.

The Multi Scan NXA83 will now save the new database to the flash drive and reboot.

4.

5.

6.

4.

5.

6.

4.

5.

6.

7.

8.
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5 Connecting, Network Settings, Windows XPe
Multi Scan NXA83 configuration consists of the following sets of tasks:
� Configuring the operating system functions such as Networking, Printers etc.
� Configuring the database

The first set of tasks can be carried out either directly on the Multi Scan NXA83 using a 
keyboard/mouse or via a remote networked PC. These tasks will be described in this section.
The second set of tasks (configuring the database) can only be carried out via a remote 
networked PC, using the Tankvision Multi Scan Configurator set of tools already loaded onto 
the NXA83. This constitutes the bulk of the configuration work for the Multi Scan NXA83 
and is covered in a separate Configuration manual. An introduction to the Configurator tools 
will be given in this section.

The Tankvision Multi Scan Configurator tools may also be loaded onto a separate PC, 
which must then be connected to the NXA83 via a network connection.

Any changes made to the system will not be permanent until committed in the Enhanced 
Write Filter.

5.1 Remote Control via a networked PC

In many circumstances it is not feasible to connect a Keyboard and Mouse directly to the 
Multi Scan NXA83, and in fact for most configuration work it is not recommended. In this 
case a networked PC can be used to take control of the Multi Scan NXA83 using the 
Windows Remote Desktop Connection.
The Multi Scan NXA83 and remote PC must be networked together, either as part of a larger 
network, or directly using a network cable.

To connect using a direct connection:

Set the networking on the remote PC to a Fixed IP address with a value similar to the 
Multi Scan NXA83. For instance if the Multi Scan NXA83 address is 192.168.1.250, set 
the PC address to 192.168.1.251.

Connect a network cable between the Multi Scan NXA83 and the PC. For more details, 
refer to the Installation manual (BA01290G).

On the PC open a the Windows Remote Desktop Connection (Windows Start → All 
Programs → Accessories → Remote Desktop Connection) and type the network 
adress of the Multi Scan NXA83 192.168.1.250 into the Computer field.

NXA83_Remote-Desktop-Connection

Expand Options, select the Display tab and set the size of the remote desktop to a 
minimum resolution of 1024 × 768.

4.
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NXA83_Remote-Desktop-Connection_Resolution

Connect to the Multi Scan NXA83 by clicking the Connect button. If promted, enter the 
account details for the Multi Scan NXA83. By default these will be:

� User name: Administrator
� Password: password

NXA83_Remote-Desktop-Connection_Log-In

The display on the Multi Scan NXA83 will now be shown on the remote PC. For details 
on how to stop the operator display to gain access to the operating system → ä 12.

5.

6.
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5.2 Accessing the Multi Scan NXA83 operating system

The Windows XPe operating system is normally hidden behind the main Multi Scan NXA83 
operator screens, and cannot be accessed. However, in order to carry out most configuration 
tasks, access is required to the operating system. In this case the operator display must be 
stopped.

To do this first requires keyboard/mouse input, which can be carried out in one of two ways:
� Connect a PC to the Multi Scan NXA83 using the Ethernet port and take control of the 

Multi Scan NXA83 using the Windows Remote Desktop Connection (recommended).
� Connect a keyboard and mouse to the USB ports of Multi Scan NXA83 and use the LCD 

display.

For details on the latter method → ä 10.
To stop the operator display screens, open the right (Screens) menu, select the down arrow 
to show the next bank of options and click on the Exit option.

NXA83_Grid-View_EXIT

The login screen will be displayed.
Enter the Administrator password to continue. This will be set to "password" when the Multi 
Scan NXA83 is shipped, but may be changed using the Tankvision Multi Scan Configurator 
tools.
If a valid password is entered the operator screens will close and the Windows Desktop will 
be shown.
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NXA83_Windows-Desktop_Low-Resolution

The Windows Taskbar is set to auto hide mode. To show the taskbar, move the mouse to the 
bottom of the screen.

NOTICE

Any changes of the windows settings could affect the correct operation of the Multi 
Scan NXA83. Therefore:
‣ Take extreme care when modifying any of the windows settings.

5.2.1 Exiting from the Remote Control session

If no changes have been made to the configuration and the remote desktop session is no 
longer required, then the NXA83 can be returned to the standard Operator Touchscreen 
using the Return To Main Screen shortcut.

NXA83_Windows-Desktop_Return-to-Main-Screen

1 Windows Desktop shortcut icon: Return To Main Screen

This will automatically set the screen resolution to 640 × 480 and start the operator display.

If any changes have been made to the operating system settings or the database then 
the Commit shortcut should be used instead of this option.

5.3 Network Settings

The Multi Scan NXA83 has an Ethernet port, referred to in the Windows operating system 
as Local Area Connection.

1
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NXA83_Windows-Desktop_Network-Connections

For the physical locations of the network connections, refer to the Installation manual 
(BA01290G).

The Multi Scan NXA83  is shipped with the following default network settings:
� Computer Name: NXA83
� Local Area Connection 3: Fixed TCP/IP Address: 192.168.1.250

For most applications these will be perfectly adequate and should be left as standard. 
However they may be changed at configuration time to fit in with an existing network on 
site.
To change the settings follow the procedure in the next section of this manual (→ ä 14).
The TCP/IP addresses can be changed using the Local Area Connection properties in the 
Control Panel. This includes using DHCP to dynamically assign an address on an established 
network.

Any changes will not be permanent until committed in the Enhanced Write Filter 
(→ ä 16).

5.4 Renaming the NXA83 network name

The Multi Scan NXA83 runs under the Windows XP operating system, therefore the 
computer name may be modified in the same way as any normal PC.

The network name of the Multi Scan NXA83 is set by default to "Multi", and in most cases it 
is recommended that it be left as this.

However, if the name needs to be changed then this can be performed using the following 
procedure:

Start a remote session (refer to Remote System Login section).

Open the System Properties option from the Control Panel of the remote Multi Scan 
NXA83.
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Change the Computer Name as normal. Do NOT reboot the Multi Scan NXA83 at this 
stage.

Select the option from the windows start menu;
Start → Programs → Tankvision Multi Scan Configurator → Rename SQl Instance
This will run a batch file that requires the old name to be entered, followed by the new 
name.

After this, double click the Commit shortcut to make the changes permanent.

Create a new project in the Tankvision Multi Scan Configurator software with the new 
network name.

Upload configuration from the Multi Scan NXA83.

NOTICE

Modifying the NXA83 name will have repercussions in the Tankvision Multi Scan 
Configurator tool as it uses that name to communicate with the Multi Scan NXA83. 
Therefore:
‣ The project settings will have to be edited as shown below.

NXA83_Windows-Desktop_Project-Settings_Device-Network-Name

1 Renaming the NXA83 network name

5.5 Changing the Multi Scan NXA83 Network Address

The Multi Scan NXA83 runs under the Windows XP operating system, therefore the network 
address and mode may be modified in the same way as any normal PC.

The network protocol is set to TCP/IP, but the address may be set as required. This includes 
using DHCP to dynamically assign an address on an established network.

4.

5.

6.

7.

1
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The network settings will be set by default to: FIXED address of 192.168.1.250.

The network settings may be changed by the carrying out the following:

Start a remote session (refer to Remote System Login section).

Open the Network Connections option from the Control Panel of the remote Multi Scan 
NXA83.

Modify the settings as normal.

After this, double click the Commit shortcut to make the changes permanent. 
The remote session will be disconnected.

5.6 Printer Settings

In order for the print features in the Multi Scan NXA83 to work, a printer needs to be 
configured in the Windows XPe operating system as the DEFAULT printer.
A printer can be installed after the Multi Scan NXA83 has been shipped, in the same way as 
installing on a normal PC running Windows XP. However, due to the restrictions on the flash 
disk space, it is recommended that only the basic printer driver should be loaded and not any 
print utilities.
For the above reason it is recommended that Endress+Hauser should be consulted on the 
type of printer to be attached to the Multi Scan NXA83.
The printer should normally be connected to the Multi Scan NXA83 via one of the USB ports. 
However network printers can also be supported.

Any printer setting changes will not be permanent until committed in the Enhanced 
Write Filter.

5.7 Connecting a modem

The communications layer of the Multi Scan NXA83, DCC, can handle modem 
communications on both master and slave interfaces.
At the moment an external modem should be used, connected to one of the serial ports. 
However it should also be possible to connect via the USB ports.
The modem driver should be installed on the operating system as for a normal PC running 
Windows XP.
It is recommended that Endress+Hauser should be consulted before selecting the modem, or 
Endress+Hauser can supply a suitable modem.

Any modem setting changes will not be permanent until committed in the Enhanced 
Write Filter.

5.8 Enhanced Write Filter (EWF)

The Multi Scan NXA83 runs under the Windows XP Embedded (XPe) operating system, 
which includes a component called the Enhanced Write Filter (EWF).
This prevents files from being corrupted by a sudden loss of power; therefore it is perfectly 
safe to switch off the Multi Scan NXA83 without shutting down the operating system.
It works by caching all disk and operating system changes. The cache is only permanently 
written to the flash disk when an EWF COMMIT action is called. This action saves the data 
to the flashdisk then reboots the Multi Scan NXA83, thus making the modifications 
permanent. If the Multi Scan NXA83 is rebooted without a commit, or loses power, then all 
changes are lost.
To commit changes, double click on the Commit desktop shortcut.

4.



Tankvision Connecting, Network Settings, Windows XPe

Endress+Hauser 17

NXA83_Windows-Desktop_Commit

1 Windows Desktop shortcut icon: Commit

Follow the instructions in the Commit window.

NXA83_Windows-Desktop_Commit_EWF-Window

1
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NXA83_Windows-Desktop_Commit_Commit-Window

Press any key and the system will save all data permanently to the flash drive before 
rebooting.
The data may also be committed using the Tankvision Multi Scan Configurator tools. Refer 
to the online manual with that product for more details.

NOTICE

Risk of malfunction!
‣ Never disable the enhanced write filter!

5.9 Configuring the Multi Scan NXA83 database

The Multi Scan NXA83 is configured using the Tankvision Multi Scan Configurator software 
which is pre-installed on the D drive.
The Configurator software may also be installed on a separate PC if required, although it is 
recommended that the onboard tools are used.
To run the Configurator software on the NXA83, a suitable PC should be connected to the 
Multi Scan NXA83 via a standard Ethernet network. This could be as part of a larger network 
or using a direct network cable between the PC and the Multi Scan NXA83.
Before running the software, the user should log onto the NXA83 using the Windows 
Remote Desktop Connection and shut down the tankgauging display, so that access to the 
NXA83 operating system is available. Refer to previous sections of this manual for details on 
how to do this.
To start the Configurator tools, double click on the Tankvision Multi Scan Configurator 
icon on the NXA83 desktop.
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NXA83_Windows-Desktop_Tankvision-Multi-Scan-Configurator

1 Windows Desktop shortcut icon: Tankvision Multi Scan

The Multi Scan NXA83 database may be uploaded to the Configurator software, modified, 
then downloaded to the Multi Scan NXA83. Database transfer to or from the Multi Scan 
NXA83 is carried out by the Database Transporter sub-system.
The user can store the databases for different Multi Scan NXA83 in projects, which may be 
reloaded for later use. It is, however, best practice to upload the current database from the 
Multi Scan NXA83 before carrying out any modifications.

The configurator software allows the Multi Scan NXA83 to be configured for a wide range 
of functions, including:
� Host and Slave Communication ports
� Tank Inventory Data
� Programmable alarms
� Products
� Manual data
� Strapping data

The standard tank gauging displays for the Multi Scan NXA83 may also be configured to 
display only the data required.
For full details on how to configure the database → ä 33.

1
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5.10 Quick Start Configuring the Multi Scan NXA83 data-
base

This section gives a quick overview on how to connect the Multi Scan NXA83 to a Remote PC 
and upload a configured database.

To Upload the existing database from the Multi Scan NXA83:

Connect a network cable between the PC and the left hand RJ45 network socket on the 
Multi Scan NXA83.

Configure the network settings on the PC to use a fixed IP address of 192.168.1.251.

Ensure the Multi Scan NXA83 is running.

Start a Remote Control session from the PC and connect to the NXA83. → ä 10

Close the NXA83 tankgauging screen, to get access to the operating system. → ä 12

Start the Tankvision Multi Scan Configurator software from the link on the Windows 
Desktop.

Select the New Project item from the File menu.

Enter a project name, leave the other settings as "Multiscan" and "ROOT", and click OK. 
This will load a blank database.

Select the Database Transporter item from the File menu.

Click on the Import Database button. This will proceed to transfer the database from 
the Multi Scan NXA83 to the PC. Click OK when complete.

Exit the Database Transporter

Select Save Project from the File menu.

The database may now be edited using the options in the Communications and 
Configuration menus.
Modify the display to show the data fields required, by selecting the item Display in the 
Configuration menu.

To Download a modified database to the Multi Scan NXA83:

Ensure network connections are setup and working.

Select Save Project from the File menu.

Select the Database Transporter item from the File menu.

Click on the Export Database button. This will proceed to transfer the database to the 
Multi Scan NXA83 from the PC.

Click OK to acknowledge the message confirming the export.

Exit the Database Transporter.

Exit the Configurator software.

Carry out a COMMIT to reboot the NXA83 and save all data. → ä 16

The Multi Scan NXA83 will now save the new database to the flash drive and reboot.

5.11 Data Communications Controller

5.11.1 Stopping and Starting DCC

The DCC communications sub-system can be accessed.

4.

5.

6.

7.

8.

9.

10.

11.

12.

4.

5.

6.

7.

8.
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The DCC runs as a set of services; they are automaticdally started when the Multi Scan 
NXA83 is restarted. There may, however, be times when it is necessary to stop or restart the 
services.

The Multi Scan NXA83 has a watchdog enabled by default. If the DCC Communications 
is stopped whilst the watchdog enabled, the Multi Scan NXA83 will be automatically 
re-booted after one minute. This will result in the loss of the remote session and any 
changes not yet saved. For details on how to disable the watchdog → ä 24.

To Stop the DCC services, double click the DCCConfig shortcut on the Windows Desktop.

NXA83_Windows-Desktop_DCCConfig-Icon

1 Windows Desktop shortcut icon: DCCConfig

To stop the DCC services click on the Stop Services button.

See the screen below to show that DCC Host has stopped.

NXA83_DCC-Config_Start-Stop-Services

Data Communications Controller

1 Stop Services Button
2 Start Services Button

When all Service Details have changed to Stopped the button will change to Start Services.

To start the DCC Host again, simply click the Start Services button. After a few moments all 
installed services should change to Running.

1

1 2
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5.11.2 DCC Comms Monitor

To view the DCC Host Communications Monitor, double click the Comms Monitor shortcut 
icon on the Windows Desktop:

NXA83_Windows-Desktop_Comms-Monitor

1 Windows Desktop shortcut icon: Comms Monitor

This will bring up the following screen:

NXA83_Windows-Desktop_Comms-Monitor-Window

The DCC Host module allows the user to view the data communication that occurs between 
the Multi Scan NXA83 and any connected devices such as tank gauges. 

To view communications, select the desired Host COM port from the drop down list. e.g. 
Com 1. A list of gauges being polled on the selected COM port will be displayed in the box 
below.

One item always available in the COM Port drop down list is SIMULATOR, this is a software 
feature which simulates gauges within DCC Host and is treated exactly the same as a normal 
COM port.

NXA83_Windows-Desktop_Comms-Monitor-Window_Simulator

1
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A blue arrow scrolls through the device list to indicate the gauge currently being polled. A 
red arrow will be displayed against a device being polled on fast scan.

The numbers in the list of gauges refers to the Tank Address of each gauge, entered in the 
Gauge Configuration screens. To display the name of the gauge in the list, hover the mouse 
over the Tank Address of the gauge.

NXA83_Windows-Desktop_Comms-Monitor-Window_Gauge-Name

Other sections of the Comms Monitor window are Configuration, Statistics, Product 
Information, Status and Incoming Raw Data.

Configuration shows:
� Slave Address – as configured in the DCC Host Comms TAB
� Group Address – not used on the Multi Scan NXA83 and set to 0 by default.
� Gauge Address – the address of the currently selected gauge. If no gauge is selected this 

field shows the addresses of all gauges connected to the selected COM port.

Statistics shows:
The number and validity of messages and responses since the COM port was selected.

Product Information shows:
The Level, Flow Rate and Temperature of the selected gauge. If no gauge is selected this 
section will not be updated and will either remain blank or display -1 to indicate no valid 
data.

Status shows:
The current status of the gauge being monitored by the DCC Host. If any status flags have 
been set, a number will appear in the corresponding box. Detailed status analysis can be 
obtained by clicking on  to expand the relevant section in a pop-up window. E.g. in the 
diagram below an Alarm Status code of 03 has been triggered. Opening the Alarm Status 
window shows this relates to a Level High-High Alarm. 

NXA83_Windows-Desktop_Comms-Monitor-Window_Alarm-Status

If no gauge is selected this section will not be updated and all boxes will display 00.
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Incoming Raw Data shows:
The raw data being sent between the Multi Scan NXA83 and the attached gauge. To 
interpret this data will require specialized knowledge of the gauge protocol being used and 
is consequently only of use for maintenance and diagnostics purposes. Use of the DCC Host 
Comms Monitor is not recommended for general operations.

If no gauge is selected to be watched, the Raw Data section will display the connection status 
of interface, this will be one of the following:
� Disconnected
� Connecting
� Connected
� Disconecting

If an interface is not in the Connected state, then no messages will be sent to any gauges on 
that interface.

5.12 Multi Scan NXA83 Watchdog

The Multi Scan NXA83 has a system watchdog component that monitors the health of the 
DCCHost communication service. If no communications occur (i.e. gauge data is not updated) 
for one minute, the Multi Scan NXA83 will reboot automatically.

The watchdog may be disabled by starting a remote session (refer to previous section for 
details) and the double clicking the Disable Watchdog shortcut on the Windows desktop.

NXA83_Windows-Desktop_Disable-Watchdog-Icon

1 Windows Desktop shortcut icon: Disable Watchdog

This will display a DOS window prompting for a reboot of the NXA83. Hit any key to reboot 
the NXA83 with the watchdog disabled. 

To re-enable the watchdog, repeat the above sequence but select the Enable Watchdog 
shortcut.

NOTICE

If the watchdog is disabled and there are problems with the processor board hardware 
or with any of the DCC comms services, the system will not reboot. It will just stay in 
faulty mode. Therefore:
‣ Do not leave the watchdog permanently disabled!

1
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6 NXA83 Configuration

6.1 System Configuration

The Multi Scan NXA83 is configured using the Tankvision Multi Scan Configurator software 
which is installed onboard the NXA83 as standard. A PC is then required to connect to the 
NXA83 using Remote Desktop Connection, to run the Configurator software.
The Multi Scan NXA83 database may be uploaded to the Configurator Software, modified, 
and then downloaded to the Multi Scan NXA83. Database transfer to or from the Multi Scan 
NXA83 is carried out by the Database Transporter sub-system.
The Configurator PC should be connected to the Multi Scan NXA83 via a standard Ethernet 
network. This could be as part of a larger network or using a direct cross-over network cable 
between the PC and the Multi Scan NXA83.
The user can store the database for different Multi Scan NXA83 in projects, which may be 
reloaded for later use. It is, however, best practice to upload the current database from the 
Multi Scan NXA83 before making any modifications.

The Configurator software allows the Multi Scan NXA83 to be configured for a wide range 
of functions, including:
� Host and Slave Communication ports
� Tank Inventory Data
� Programmable alarms
� Products
� Manual data
� Strapping data

The standard tank gauging display for the Multi Scan NXA83 may also be configured to 
display only the data required.

6.2 Tankvision Multi Scan Configurator

6.2.1 Tankvision Multi Scan Configurator

The Multi Scan NXA83 is configured using the Tankvision Multi Scan Configurator software. 
This is started by double clicking on the Tankvision Multi Scan Configurator icon.
It is recommended that the Configurator software is run from the Multi Scan NXA83. In this 
case, connect to the Multi Scan NXA83 via a Remote Desktop Connection from a networked 
PC and shut down the tankgauging display. The Tankvision Multi Scan Configurator icon 
can then be found on the Windows desktop. For more details → ä 10.
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NXA83_Configurator

All configuration actions are accessed from this software.

6.2.2 Projects

The Configurator may be used to configure many Multi Scan NXA83 devices, by saving each 
NXA83 to a new project within the configurator.
Only one project may be opened at a time, and each project has the database for one Multi 
Scan NXA83.
The current open project is shown in the top right of the Configurator screen.

NXA83_Configurator_Configuration_Current-Project

1 Configurator Screen: Current open project

When started, the Configurator will open the last previously opened project.
All actions carried out in the Configurator will be saved in the current project database unless 
the Save As option is selected in the File menu.

Each project must contain the following configuration data:
� Device Network Name: This is the network name of the Multi Scan NXA83 and is 

required for all transfer of data to/from the device. This will default to "Multiscan", but the 
Multi Scan NXA83 may be configured differently. If the Network Name is not set the same 
as the Multi Scan NXA83 then all database transfers will fail.

1
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� Device Data Directory: This is the share name of the data directory on the Multi Scan 
NXA83. This should ALWAYS be set to "ROOT". Do not change.

� Number of Ports: This is the number of serial ports supported by the NXA83. The default 
is 8.

To change the current project, click on the File menu

NXA83_Configurator_New-Project

When carrying out project actions, if the current project has been edited, a message will be 
displayed with a prompt to save the existing data.

NXA83_Configurator_Project_Save-Changes

Click Yes to save the existing project, after which the new project actions will take place.
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6.2.3 New Project

To create a new blank project select New Project from the File menu:

NXA83_Configurator_Create-New-Project

Enter the new project name, and then configure the details of the remote Multi Scan NXA83 
in the Project Settings.
These settings are important for establishing communications with the remote device; for a 
description → ä 26.
Click OK to create the new project and set it as the currently open project in the Configurator.

Before creating a new project always save any changes to the current open project, as 
they will be discarded when the new project is created.

6.2.4 Open Project

To open an existing project select Open Project from the File menu.
Select from the list of projects, and then click on OK.

NXA83_Configurator_Open-Project

The project details and database will be loaded into the Configurator as the current open 
project.

Before opening a project always save any changes to the current open project, as they 
will be discarded when the selected project is opened.



Tankvision NXA83 Configuration

Endress+Hauser 29

6.2.5 Edit Project

To edit the settings for the currently opened project select Edit Project from the File menu:

NXA83_Configurator_Edit-Project

� Device Network Name: The name in the project settings must match that of the Multi 
Scan NXA83 for database transfers to work.

� Device Data Directory: Should ALWAYS be set to "ROOT". Do not change.
� Number of Ports: Select the Number of Ports supported by the Multi Scan NXA83.

6.2.6 Saving Projects

To save the current open project, select Save Project from the File menu.
To save the project and all its data to a new project, select Save As from the File menu:

NXA83_Configurator_Save-Project

Enter the new name for the project then click OK.
The current open project will be changed to the new project.
An existing project may be specified, in which case that project will be overwritten.
Saved projects files will be written to a directory with the name of the project. This directory 
will be located at:
D:\Program Files\Tankvision Multiscan Configurator\Projects

6.2.7 Backing up and restoring projects

To make a backup of a project to a USB memory stick, carry out the following:

Save the project via the Tankvision Multi Scan Configurator.

Plug a memory stick into a free USB port.

Copy the saved directory (→ ä 29) to the USB memory stick.
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Carry out a COMMIT.

Remove the USB memory stick after the reboot.

To restore a backup project or load a project from another Multi Scan NXA83, carry out the 
following:

Plug the memory stick containing the backup project into a free USB port.

Copy the backup project directory from the USB memory stick to the location: 
D:\Program Files\Tankvision Multiscan Configurator\Projects

Start the Tankvision Multi Scan Configurator and open the project (→ ä 28).

If the project is from another Multi Scan NXA83 then use the Edit Project option and 
check that the Device Network Name is changed to the current Multi Scan NXA83 
name.

Use the Database Transporter to export the database, then carry out a COMMIT.

6.3 Database Transporter

6.3.1 Database Transporter

The Database Transporter is responsible for transferring the database to/from the Multi 
Scan NXA83 and is accessed via the File menu in the Configurator:.

NXA83_Configurator_Database-Transporter

The current open project is displayed in the top right of the screen. The network name for 
the Multi Scan NXA83 is displayed in the Name field. It is important that this is set to the 
same as the network name of the Multi Scan NXA83, if there is a difference then no 
transfers will take place.

6.3.2 Exporting to the Multi Scan NXA83

To transfer the database to the Multi Scan NXA83, click on Export Database.
The progress of the transfer will be displayed, see below.

4.

5.

4.

5.
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NXA83_Configurator_Database-Transporter_Export

At the end of the transfer a message will be displayed informing whether the database 
export was successful or not.

NXA83_Configurator_Database-Transporter_Export-Successful

Click OK to close the window then Exit the Database Transporter.
The database will be transferred but changes will not take effect, or become permanent until 
written to the Flash drive by a re-boot of the operating system. This means that if the device 
is switched off before a re-boot has taken place all changes will be lost.

6.3.3 Re-booting

If new data has been downloaded to the Multi Scan NXA83, it will not be permanently saved 
to the flash drive until a re-boot of the operating system has occurred. This is normally 
carried out at the end of an export. However it may be carried out at any time after an export.

� If the Configurator software is running onboard the Multi Scan NXA83, then close the 
Tankvision Multi Scan Configurator and double click on the Commit shortcut icon on the 
NXA83 Desktop.
A DOS window will open. When prompted, press any key to re-boot the Multi Scan NXA83 
to permanently save the changes.

NXA83_Windows-Desktop_Commit

1 Windows Desktop shortcut icon: Commit

The Multi Scan NXA83 has a software component installed called the Enhanced Write Filter 
(EWF). This prevents files from being corrupted by a sudden loss of power. Once data has 
been written to the Flash Drive it is perfectly safe to switch off the Multi Scan NXA83 
without shutting down the operating system.

1
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6.3.4 Importing From the Multi Scan NXA83

To transfer the database from the Multi Scan NXA83 to the Configurator, click on Import 
Database.
The progress of the transfer will be displayed.

NXA83_Configurator_Database-Transporter_Import

At the end a message will display if the database import was successful or not.

NXA83_Configurator_Database-Transporter_Import-Successful

The database imported from the Multi Scan NXA83 will overwrite the existing database in 
the Configurator.
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7 Database Configuration

7.1 Port Configuration

7.1.1 Port Configuration

The Multi Scan NXA83 has a component installed called the Data Communications 
Controller (DCC) which consists of a number of services responsible for transmitting tank 
data to and from the device.

The three main services are:
� DCC Host - responsible for retrieving data from gauges and storing it in the database
� DCC Slave - responsible for sending tank data to other computer systems
� OPC Server - responsible for providing tank data to OPC clients

The Host and Slave services control communications over a number serial ports on the Multi 
Scan NXA83 and these must be configured with a software protocol before they can be used.
The OPC Server service communicates via the network and requires no configuration.
This section of the manual provides an overview of how to configure the NXA83 
communications sub-system. For a more detailed description refer to the separate DCC 
Configuration manual (BA01292G).

7.1.2 Data Communications Controller

The ports used in the DCC component of the Multi Scan NXA83 are configured by selecting 
the Port Configuration option from the Communications menu of the Tankvision Multi 
Scan Configurator.
This consists of a number of tabbed pages to configure the Host and Slave ports.

NXA83_Data-Communications-Controller

The License tab allows the licensing details to be viewed for the current open project. These 
are automatically retrieved from the Multi Scan NXA83 when the database is imported.
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NXA83_Data-Communications-Controller_License

7.1.3 Configuring a Host or Slave port

Host ports are responsible for collecting data from Datacons and gauges, and command 
requests from any PC Tankgauging clients.
Slave ports are responsible for sending data to other computer systems, such as the main 
Distributed Control System (DCS) for the refinery, using protocol such as Modbus.

To configure a port click on the Host Comms or Slave Comms tab in the Data 
Communications Controller tool.
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NXA83_Data-Communications-Controller_Host-Comms

A list of all physical COM ports (RS232/485/422 etc.) will be displayed together with any 
logical Modem and Network ports configured (they will have an offset of 40 for Modems, 70 
for Network and 110 for OPC connections, i.e. COM 41, 71, 111 etc.).

For Modem ports click on Add Modem Port, for Network ports click on Add Network Port, 
for OPC ports click on Add OPC Port to automatically add the port to the list.
Select the COM port to configure and make sure the In Use box is ticked.

A warning message may be displayed if a new Host port is added by selecting the In Use box 
and the number of licensed host interfaces has been exceeded.

NXA83_Data-Communications-Controller_Host-Comms_Interfaces-exceeded

Select the Protocol to be used on the port, from the drop down menu..

Retries determines the number of consecutive failed polls before a communications failed 
alarm is generated for host ports.

The Background Scan Period determines the update times for certain gauge parameters, 
such as Density, Observed Temperature, Pressures, Vapour Temperature, Multi-Element 
Temperatures and Water Level. It is not used for Slave ports.
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For Host ports the Connect section determines when to connect to the COM port or Modem 
and poll the gauges. This will default to Always Poll. The following options may be selected 
from the drop down.
� Always Listen – mode for slave interfaces
� Always Poll - Interface will always try to be connected and polling the gauges
� Manual - Interface will only connect and poll gauges if manually commanded by User
� Scheduled by Hour - Interface will connect on the hours selected by the user
� Scheduled by Interval - Interface will connect periodically

7.1.4 Configuring Scheduled Connections

Scheduled connections are normally used on Modem ports, where the host port will connect 
to the remote site, poll for all the data and then automatically disconnect.
For scheduled connections the times to connect must be configured by clicking on the 
Configure button next to the Connect field.

If the Scheduled by Hour option was selected then the hours on which the interface will 
connect may be defined in the dialog box displayed:

NXA83_DCC-Config_Host-Comms_Scheduled-Connect

The Max Connection Time field defines the maximum time in minutes that the interface 
will remain connected and polling the gauges before it will disconnect. Normally the 
interface will disconnect automatically after it has retrieved all data from then gauges. This 
field should be set to longer than the time it takes to update all data. The main purpose for 
this field is to limit the time a modem will remain connected if problems occur polling the 
gauges.

The minutes field in the Connect at selected Hours section defines the minutes past the 
hour that the connection will take place.

If problems are experienced with scheduled connections where some data is not being 
retrieved, it may be that the Max Connection Time is too short. In this case, increase the 
Max Connection Time.

If the Scheduled by Interval option was selected, the interval between connections must 
defined in the dialog box displayed:
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NXA83_DCC-Config_Host-Comms_Scheduled-Connect-Interval

The Max Connection Time is the same as for the hourly connection display.

7.1.5 Configuring DCC Host Options

The Options section allows the operation of DCC Host to be modified as required. Current 
options supported are shown below:

NXA83_DCC-Config_DCC-Options

� Manual levels set Programmable Alarms - by default a manual value will not trigger a 
programmable alarm, ticking this option will reverse this functionality.

� Servo/Stow set Programmable Alarms - by default when a gauge is moving due to a 
stow/unstow or servo command then programmable level alarms will be suppressed, 
ticking this option will reverse this functionality so that the current position of the sensing 
head will be used to trigger alarms.

� Log Profiles to CSV file - when this option is ticked, the results of profile scans (Density, 
Pressure, Temperature etc.) will be saved as CSV data files. The file is stored in 
D:\Historical\Profiles using a filename of the format:
<tankname>_<Gauge Number>_<Date>_<Time>.csv

� Display Error Messages - This option causes a pop-up message box to be displayed with 
any error information if DCC Host crashes.

� Auto control the manual mode for water level - ticking this option will set DCC to 
automatically set the water field into manual mode if the value from the field is invalid.

� Set Flow to Zero if below threshold - be default all flow data will be saved regardless of 
what the value is. This may lead to a flow being displayed that is due to the "ripple" of the 
product. Ticking this option will set DCC to clamp all flow rates to zero if the value is below 
the flow rate threshold value entered in the System Settings.
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� Suppress Alarms when Displacer Above Liquid Surface – ticking this option will set DCC 
to ignore any level alarms returned from the gauge, but only when the displacer is above 
the product surface i.e. not following level. For instance when servoing or stowing etc.

� Suppress Alarms when Displacer Below Liquid Surface – ticking this option will set DCC 
to ignore any level alarms returned from the gauge, but only when the displacer is below 
the product surface i.e. not following level. For instance when profiling or finding water.

There are also a number of Data Synchronization options which can be set when the Multi 
Scan NXA83 is connected to a Host Tankgauging computer.
� Auto Sync Manual Data – When selected, any changes made to manual data (e.g. setting 

fields to Manual/Auto or setting manual values) on the Host computer will also be set on 
the Multi Scan NXA83.

� Auto Sync Tank Inventory Data - When selected, any changes made to tank inventory 
data (e.g. Changing Tank Capacity Tables) on the Host computer will also be set on the 
Multi Scan NXA83.

� Auto Sync Alarm Data - When selected, any changes made to alarm data (e.g. Alarm set-
points or activating/deactivating alarms) on the Host computer will also be set on the 
Multi Scan NXA83.

� Auto Sync Movement Data - When selected, any changes made to movement data (e.g. 
flow rate set-point) on the Host computer will also be set on the Multi Scan NXA83.

� Auto Sync Gauge Configuration Data - When selected, any changes made to gauge 
configuration data (e.g. tank name or product) on the Host computer will also be set on the 
Multi Scan NXA83.

7.1.6 Communications Parameter Configuration

Each Host or Slave port requires the Hardware configuring for the communication 
parameters. These parameters differ depending on the hardware, i.e. Physical COM ports, 
modems or Network connections.
Click on the Configure button next to the Hardware field to configure the communication 
parameters for the port.

Serial ports

Serial ports require the Baud rate, Parity, Data Bits and Stop Bits configuring. Flow 
Control should always be set to None, except for SAAB protocol ports where it should be set 
to RTS.
If the serial communications hardware produces an echo of sent characters (i.e. some RS485 
or 20 mA current loop devices) then tick the Echo Expected field to tell the driver to handle 
the echoed characters.
The Redundancy Settings fields are only used if Redundancy has been enabled in DCC, and 
has been selected as either Switch By Interface or Switch By System.
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NXA83_Data-Communications-Controller_Host-Comms_COM-Port-Settings

The Timeout Period is used to determine if a port has failed and should trigger a switch 
over. Switchover occurs if there has been no valid communication packets received from 
gauges for at least the Timeout Period.
For the redundancy mode Switch By System, a port can be disabled from causing a 
switchover by ticking the item Do Not Trigger Redundant Switch.

Modem ports

Modem ports require the Modem and Phone Number to be configured.

NXA83_Data-Communications-Controller_Host-Comms_Modem-Settings

The Modem should be selected from those installed in the operating system.

Network ports

Network ports require the Network Address, IP Port and the Delay Between Polls to be 
configured.
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NXA83_Data-Communications-Controller_Host-Comms_Network-Settings

The Network Address is the address of the remote computer connecting to the Multi Scan 
NXA83 and may be entered as a TCP/IP address or the PC name. The IP Port should be 
entered for the interface running on the remote system.
The Delay Between Polls is only required for host ports and should generally not be set 
below 100 ms.
For slave ports the Timeout for inactive connections setting is used to disconnect the 
remote system if no requests have occurred for that length of time. Setting this value too low 
could affect communications. It should normally be set to 60 seconds (60000 ms).

OPC ports

The Protocol type will always be set to OPC TG. The Retries, Background Scan Period and 
Redundancy Settings fields all function in the same way as for a normal COM port.
The Hardware section requires configuring with the network name or IP address of the 
remote network device that the OPC server is running on. It also requires the OPC server 
details, such as the Prog Id and CLSID. 
To enter these details click on the Configure button to the right of the Hardware field.

NXA83_DCC-Config_OPC-Settings

Enter the Network Address of the remote network device (i.e. PC) to connect to. This may 
be entered as the name of the device (i.e. PC name) or as its TCP/IP address, for example 
192.168.1.86.
If the name of the remote device is to be used, ensure that it is known to the system that DCC 
Host is running. This is usually the case if both systems use the same DNS server.
To select the OPC server details, ensure that the Network Address has been entered and then 
click on the Browse ID button.
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NXA83_DCC-Config_OPC-Settings_Select-OPC-Server

This will display a list of all OPC Data Access (DA) servers (and Alarm Event servers, 
although these are not supported at the moment) on the remote machine. Select the correct 
server then click on OK.

NXA83_DCC-Config_OPC-Settings_DataServer

The OPC DA server details will be automatically saved in the OPC settings fields. If the OPC 
server system is not connected to the local system at the time of configuring the port then 
the OPC Prog ID and OPC CLSID fields may be either manually entered, or left blank until 
commissioning time. However they must be entered at some time before the system is 
commissioned.

7.1.7 Redundancy

The DCC Host service supports redundant communications to gauges using a pair of 
communication ports (Physical COM ports, modems or Network connections).

Any ports that are to be used as part of a redundant communications system should have 
their Redundancy Settings field set to one of the following:
� Switch By Interface – where gauges will only switch to the Backup COM port if ALL 

gauges have failed on that interface
� Switch By Gauge – where gauges will switch individually
� Switch By System – where two systems (i.e. NXA83) are connected by Redundant Control 

Links and only one system will poll the gauges at one time

After the interfaces have been configured, gauges may be configured with redundant 
operation. To do this, select the gauge in the Gauge Configuration screen in Tankvision 
Multi Scan Configurator, then set the Comm Port fields to the desired Primary Interface 
Comm Port and Backup Interface Comm Port.
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NXA83_Device-Configuration_Comm-Port_Primary_Backup

1 Primary Interface Comm Port
2 Backup Interface Comm Port

Switch By System Redundancy

For Switch By System redundancy, two extra ports are required, and MUST be configured as:
� 1 DCC Host port configured as a Redundant Link Control protocol
� 1 DCC Slave port configured as a Redundant Link Control protocol

When the gauges are configured, they ALL must have the Backup COM port set to be the 
Host Redundant Link Control port.
In operation the Host Redundant Link Control is connected to the Slave Redundant Link 
Control of the other system, and vice-versa.

7.2 Configuring protocols

Most of the Slave protocols (Modbus, Enraf etc.) and some Host protocols (Modbus TG) 
require extra configuration that is specific to the protocol.
To configure any protocol specific data, select either the Modbus TG Configuration or the 
DCC Slave Configuration item from the Communications menu

1 2
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NXA83_DCC-Host-Configuration_User-Defined-Alarm

Modbus TG Configuration Screen

NXA83_DCCSlave-Configuration

Refer to the separate DCC configuration manual for details on configuring the protocol data.
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7.3 Gauge Configuration

The Multi Scan NXA83 must be configured for all gauges which will be used in the database.

This consists of defining data for each gauge, such as name, type, COM port etc., and is 
carried out using the Gauge Configuration tool.

7.3.1 Gauge Configuration

To launch the Gauge Configuration tool, select Gauge Configuration from the 
Communications menu. The Gauge Configuration will hold any gauges/field devices that 
are already configured, for review or editing of their settings. Alternatively, the form will be 
empty if no gauges/field devices have been configured yet.

Each manufacturers gauge has different basic requirements for configuration. A knowledge 
of the different makes and models of gauges is useful at this stage although not essential, 
provided that the characteristics of the actual gauges present in the system are known. The 
following instructions do not provide an exhaustive guide as to the valid options and 
selections for each type of gauge; rather instruction is given as to the way in which the 
information is entered into the system. Application notes and manufacturer's literature 
should be consulted for further information.

NXA83_Device-Configuration

Some fields will only be displayed if certain options are selected. These include the 
Gauge Duty, Slave Datacon/Port Address frames which will only be displayed if their 
respective options are selected.

The form displays the configuration of one device (such as a gauge) at a time. The buttons 
on the lower left of the form navigate through the list of gauges. The < and > buttons move 
one gauge back or forward respectively. The |<< button moves to the first gauge and the 
>>| button moves to the last. The Device Number drop-down list provides an alternative 
means of navigating directly to a particular gauge. The Device Numbers are allocated 
automatically by the system as new gauges are added, generally in order of creation, and 
cannot be edited by the user.
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To add a new device to the list, click on the Add button. A new blank entry will be displayed 
and the editing features will be enabled. Alternatively, a new gauge may be added to the list 
by copying an existing one. In this case, click on the Copy button and then select the gauge 
from which the copy should be made. This will produce a new entry and the editing features 
will be enabled, but the displayed settings will replicate those of the gauge from which the 
copy was made. The effect of adding a gauge to the configuration will usually be to add a 
corresponding tank to the Multi Scan NXA83 display, unless the gauge is part of a multi-
gauge setup.

To delete an existing device, click on the Delete button. Doing so will remove the 
corresponding tank from the Multi Scan NXA83 display unless the device is part of a multi-
gauge setup.

To edit the configuration of an existing device, navigate through the list to the desired device 
and then click on the Edit button.

The buttons at the right side of the form will be enabled (black text) or disabled (greyed out) 
depending upon the context of what stage in the configuration the user is at. For example, 
the Save button will be enabled whenever any setting for the currently displayed device is 
changed, prompting the user to apply any changes before moving on to another device. A 
message box will be displayed as a further reminder to apply changes.

Closing the tool by means of the Exit or × button or selecting a different device without first 
saving will discard any changes made. To discard any erroneous changes made whilst editing 
the configuration of a device, click on the Cancel button.

When configuring a new device, it is recommended to progress through the selections and 
options in column order, starting by working down the left column. Certain selections, e.g. 
Device Type, will affect the appearance and data entry requirements of other settings and 
options further down the column and may "clear" any current settings in preparation for the 
user's new entries.

The following fields are not required for the Multi Scan NXA83: Master Datacon Name, 
Datacon Gauge Index, Slave Datacon Name and Port Address, and the last three fields will 
only be displayed if a Master Datacon Name is specified.

The Device Type drop-down list provides a selection of gauges and field devices of various 
models from various manufacturers. Select the one that matches or most closely resembles 
the actual gauge or device which will be connected. Note that the selection affects the way 
in which the communications of the Multi Scan NXA83 behaves.

The Tank Id entry links the gauge to a tank in the Multi Scan NXA83 system. Typically, each 
gauge will be associated with a unique tank, though in the case of multi-gauge setups there 
will be a number of gauges all fitted to the same tank and thus share a common Tank ID.

Comm Port is the number of the port on the Multi Scan NXA83 to which the the gauge itself 
is connected. There are two fields for the Comm Port. The left hand field is the main 
COM port used for communications, and should always have a value entered. The right hand 
field is only required for redundant systems, and specifies the Backup Comm Port.

The selections for CIU Address and Gauge Address (or their corresponding names in the 
case of other types of gauges/devices) will depend upon not only the Device Type but also 
the way in which the gauge is connected. Typically, the CIU Address is the address of the 
device which the system or Datacon communicates with, and the Gauge Address is the 
address, register or location from which the level may be read. The data format of the entries 
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(e.g. decimal/hexadecimal) will also be determined by the Device Type. The following 
examples should illustrate the typical scenarios:
� Enraf systems may include a CIU or may communicate directly with the gauges 

themselves. The level is read from the gauge using one of a number of specific requests. 
The CIU Address will be that of the actual CIU (if present) as a decimal number in the 
range "0" to "9", and the Gauge Address will be the Transmission Address of the gauge as 
a decimal number in the range "0" to "99".

� SAAB systems may also include an interface unit; this time called a FCU, or may 
communicate directly with the gauges. Here, the level is read from one of a number of 
different Modbus registers within the FCU (if present) or the gauge. The FCU Address will 
be the Modbus Slave Address of the FCU (where present) or the gauge (direct 
communications without FCU) as a hexadecimal number in the range "01" to "F7". The 
Gauge Address is the Modbus Register Address from which the level will be read as a 
hexadecimal number in the range "0" to "FFFF". Other types of gauge that use the Modbus 
protocol will also follow this same pattern.

� Whessoe systems fall into two basic types, the older of which uses a communications 
Outstation. The Outstation Address is specified as a decimal number in the range "0" to 
"15", and the Gauge Address specifies the outstation channel from which the level is read 
as a decimal number in the range "0" to "15". Later Whessoe systems do not use an 
outstation; communication is directly to the gauge. In this case only the Gauge Address is 
required and is specified as a decimal number in the range "0" to "31".

� Motherwell systems only use the Gauge Address setting, whether as an index number 
when requesting level from a communications rack or as a field address when 
communicating directly with later type gauges. The Gauge Address is a hexadecimal 
number in the range "0" to "FF".

Gauges of other manufacturers/types will generally fall into one of the above categories. If 
in doubt, consult the gauge manufacturer's literature and the Datacon configuration 
application notes.

In the case of systems that use the Datacon for field communications, the Datacon Gauge 
Index is the address or "position" within the internal configuration database of the Datacon 
where this gauge will reside. The positions are addressed from 0 to 255. Each gauge must 
have a unique Tank Address, which for convenience should normally be set the same as the 
Gauge Number. This field is not normaly required for a Multi Scan NXA83.

The Type Of Instrument and Type Of Record selections are only required for certain gauge 
types which offer different protocols or requests for level. For example, Enraf; where the 
Type Of Instrument specifies the protocol ("A" = GPP, "B" = GPU, etc.) and the Type Of Record 
specifies the request used to read level from the gauge (typically "B").

If the gauge is one of a number of gauges all fitted to the same tank, select Multi-Gauges. 
An additional frame will be displayed wherein the Gauge Duty should be selected. There 
should be only one Primary Gauge on each tank, the others should be Secondary Gauges or 
used for other specific duties as listed.

Certain gauges which are provided with multi-element averaging or multi-spot temperature 
measurement may allow the individual element temperatures to be read via the 
communications. If this feature is available and desired, select Average Temp. Fitted.

Certain gauges which are provided with skin temperature measurement may allow the 
individual temperatures to be read via the communications, up to a maximum of 
250 elements. This feature is normally only available on LNG tanks and is used in 
combination with an auxiliary gauge. If it is available and desired, select Skin Temp. Fitted.

To alter the response of the level flow rate measurement by the system, and consequently 
the volume and mass/weight flow rates, two parameters are available for user configuration. 
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The Flow Rate Damping factor is a measure of how much of the current instantaneous flow 
rate reading is incorporated into the filtered value, as a percentage. Increasing the figure 
increases the responsiveness of the resulting flow rates but reduces the effective damping. 
The Flow Rate Integration factor is a time in seconds, up to 240 seconds maximum (four 
minutes), used to increase the effect of damping where the level readings/flow rate 
calculations are performed at shorter intervals depending upon the number of gauges 
present on the particular communications port.

The Background Scan/Auxiliary settings are used to read data parameters other than 
Product Level from the gauge at lesser frequency than the level. Product Level is the primary 
data item and is the default item polled from the gauge by the system. Polls for other items 
may be inserted periodically by the system dependent upon the settings of the Background 
Scan/Auxiliary items. Where used, Auxiliary 1 is assumed to be for Product (Average) 
Temperature, and is typically polled at half to quarter of the rate of Product Level. The other 
items Auxiliary 2 to Auxiliary 16 are inserted into the normal polling sequence at three 
minute intervals. These would typically be used for live Free Water, Density, Vapour 
Pressure, Vapour Temperature etc. The format of the Auxiliary entry will depend upon the 
gauge type:

� For Enraf gauges, the Auxiliary entry is formed of the two digit decimal Transmission 
Address of the device from which the item is to be read (usually the same as the Gauge 
Address) in the range "00" to "99" including any leading zeros, followed by the one or two 
character alphanumeric code of the data item as per the Enraf GPU protocol. A single letter 
appended to the address will be interpreted as a Type Of Request, whereas a two character 
code will be interpreted as a Data Item identifier for a Z Record request. As in the example 
displayed above, Auxiliary 1 is set to request a C Record (Product Temperature), 
Auxiliary 2 will request Data Item YB (Free Water Level) and Auxiliary 3 will request 
Data Item SC (Average Servo Density). All of these auxiliary items will be requested from 
address 04, that being the same as the Gauge Address.

� For SAAB gauges, the Auxiliary items should be set to the Modbus Register Address of the 
desired data value as a four digit hexadecimal number in the range "0000" to "FFFF", 
including any leading zeros.

� Where gauges provide Product Temperature in a combined response along with Product 
Level, as is the case with Whessoe and Motherwell gauges for example, there is no need 
to set the Auxiliary 1 item to specifically request temperature.

The Multi Scan NXA83 will assume that any values read from the gauges/field devices are 
in Metric units unless the system is able to determine the measurement units of the gauge/
field device automatically via the communications. If this is the case, the Change Dimensions 
entries should be left in their default setting of AUTO. With certain gauges, the system must 
be configured specifically to match the measurement units of the data from the gauge by 
selecting the appropriate units of measure from the drop-down lists.

Once all settings for the gauge have been configured, always remember to apply the settings 
by clicking on the Save button before moving to another gauge.

DO NOT USE the Download button as it is not operational in the Tankvision Multi Scan 
Configurator software. There is a separate Database Transporter program to download 
the database to the Multi Scan NXA83.

Once all configuration has been completed, click on Exit to unload the Gauge Configuration 
tool.

7.3.2 Multi Gauges

Tanks may be fitted with more than one gauge, for enhanced reliability. For example most 
LNG tanks will typically have two level gauges, one alarm gauge and one densitometer 
device fitted. To configure multiple gauges for a tank, perform the following in the Gauge 
Configuration screen:
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Enter the same Tank Id for each gauge.

Tick the Multi Gauges box, this will display the Gauge Duty panel.

Select the appropriate duty from the Gauge Duty panel.

NXA83_Device-Configuration_Multi-Gauges-Steps

1 Drop Down Menu: Tank ID
2 Tickbox: Multi Gauges
3 Drop Down Menu: Gauge Duty

For multi-gauge tanks most configuration data entered for the tank will be saved for all the 
gauges on that tank. This applies to data entered in the Tank Characteristics and the Alarm 
Configuration screens. Consequently, when a programmable alarm is triggered on a multi-
gauge tank, an alarm event will be generated for each gauge on the tank. 

Data entered in the Manual Data screen only applies to an individual gauge. 

The Gauge Duty defines how the gauge will be treated in the various operator displays. Most 
of the default screens supplied with the NXA83 are configured to display the primary gauge 
data. However they may be configured to show data from any other duty.

The available gauge duties are listed below.

Primary
One gauge must be configured as the primary duty gauge. This is the normal gauge used to 
display tank data in the operator screens.
If a Densitometer duty gauge is also present on a tank then the Product Density and 
Observed Temperature will be automatically be copied from the Densitometer to the 
primary.

Only one Primary gauge may be configured per tank.

Secondary
If a second level gauge is required on a tank, e.g. for redundancy purposes, set the duty of 
this gauge to Secondary. The secondary gauge may be added to the displays as required and 
may be accessed via Modbus and OPC interfaces. If the Difference Alarm is enabled for a 
tank, it monitors the Primary and Secondary gauge levels and generates an alarm if they 
differ by more than the preset tolerance.

Only one Secondary gauge should be configured per tank.

1

2

3
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Backup
Any furher level gauges on a tank should be configured as Backup duty. These may be added 
to the displays as required and may be accessed via Modbus and OPC interfaces. The alarm 
gauge in an LNG tank should be configured as Backup duty.

Densitometer
This duty is only required for LNG tanks. Densitometer is used for devices such as the 
Scientific Instruments 6280/6290, although any gauge capable of carrying out profiles may 
be configured as a densitometer. The main purpose of Densitometer gauges is to carry out 
profiles and calculate the product density, which is then automatically transferred to the 
primary gauge for volume calculations.

Auxiliary
An auxiliary gauge is different from all other gauge duties. It is not treated as a separate 
gauge, instead it is used to retrieve background scan parameters (pressures, temperatures, 
water bottom etc.) from a separate device and store them in the Primary gauge. 

An auxiliary gauge will not poll for level, generate alarms or be displayed in the operator 
screens. It is typically used on a Modbus TG interface to access parameters from devices such 
as pressure transducers. All data retrieved from an auxiliary gauge will be transferred to the 
Primary gauge and used in the volume calculations. 

Parameters that may be polled on an auxiliary gauge include:
� Product Temperature
� Vapour Temperature
� Density
� All Pressures
� Multi-Element temperatures (not transferred to Primary)
� Skin Temperatures (not transferred to Primary)
� Water bottom

7.4 Tank Characteristics

Tank Characteristics enables the user to configure the tank details. The Tank Characteristics 
module can be loaded at any time to perform tank detail changes.

A number of the data items in the Tank Characteristics module are important to the tank 
inventory calculations. It is therefore essential that they are configured correctly.

The tank characteristics module is a multi-tabbed data entry form where data has been 
organized into logical groups.

The groups are:
� Tank Details
� Roof Details
� Shell Correction
� Miscellaneous
� Inventory Control Settings

Some values that appear within the Tank Characteristics module are dependent on other 
settings. Indeed some fields are not visible or enabled until they are called for by the setting 
of another parameter.
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7.4.1 Launching Tank Characteristics

Select the Tank Characteristics option from the Configuration menu. 

The following display is typical of what will be loaded. The Left pane will contain the list 
of all tanks programmed into the Multi Scan NXA83. The configuration characteristics 
for each tank can be accessed by expanding the menu tree and selecting the required 
item.

NXA83_Tank-Characteristics

OK, Apply, and Cancel buttons are provided.

The Forward and Back  buttons can be used to move through the history of edited 
pages.

7.4.2 Modifying Data Within Tank Characteristics

Select the tank to be modified from the list and expand the menu tree. Any number of tanks 
may be expanded at any time. Click on the data group to be modified. The current details for 
the tank will be displayed. 

Tank Characteristics will contain default values the first time it is loaded after installing 
the system. It is essential that default values are replaced with correct operating 
values. 

Select the field to be edited and enter/select the new data.

Each field is validated both during data entry and just before the data is saved to the 
database. 
You can use the TAB key to move to the next data entry field. 

You can move freely between configuration groups to edit/review them by selecting the 
required group from the Left pane. This is useful for making comparisons of tank details.
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Changes can be abandoned by clicking the Cancel key or clicking  to close the Tank 
Configuration window. A window will pop up requesting confirmation.

NXA83_Tank-Characteristics_Confirm-Changes

Click Yes to save any changes and exit, No to discard any changes and exit or Cancel to 
return to Tank Characteristics to review or continue configuration.

Click the Apply button to have the changes to the database take effect. This will leave the 
window open.

Clicking the Save button will save any changes and close the Tank Characteristics window. 

Data Item Definitions

The following sections provide definitions for each of the data fields within each group of the 
Tank Characteristics module.

Tank Details

NXA83_Tank-Characteristics_Tank-Details

Tank Shape – Specifies the physical shape of the tank. Four principle tank shapes are 
supported:
� VC: Vertical Cylinder
� VCFR: Vertrical Cylinder with Floating Roof
� SP: Sphere
� HZ: Horizontal Cylinder
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There are other similar tank shapes. However, most should fall into one of the above types. 
Vertical Cylinders that have internal floating blankets/decks should be configured as VCFR. 

It is essential that the tank shape is entered correctly as this affects the inventory calculation 
algorithms.

Product – Select from the list of available products in the drop down menu. Details of how 
to configure products can be found in the relevant section later in this manual.

API/ASTM Table – The API table is related to the product that will be stored in the tank. It 
defines the method and operating ranges for certain characteristics of the product. Products 
are broadly arranged into a number of recognized API tables. 

It is essential that the API table is entered correctly as this affects the inventory calculation 
algorithms.

Vapour Calculation – Specifies the vapour correction calculations that will be performed as 
part of the inventory calculations. None means that no vapour correction will be performed.

Max Operating Level – This defines the maximum operating level of the tank. The accuracy 
of this value is important as it is used to determine the maximum operating volume and 
consequently the amount of Ullage Volume (Available Room) in the Tank.

Min Operating Level – This defines the minimum operating level of the tank. The accuracy 
of this value is important as it is used to determine the minimum operating volume and 
consequently the amount of Usable Volume in the Tank.

Reference Height – This is the Ullage Zero level used as an alternative to maximum 
operating level for product. This is used to set the maximum operating volume and 
consequently the amount of Ullage Volume (Available Room) in the Tank.

Min & Max Operating Volume – Are read-only fields provided for your reference.

Roof Details

The Roof Details section is only relevant to floating roof tanks i.e. those that have been 
defined with a tank shape of VCFR.
This section is disabled for all other tank shapes.
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NXA83_Tank-Characteristics_Roof-Details

Leg Position
Some floating roofs have legs which may be set at two positions, thus altering the level at 
which the roof floats or is supported on the legs. Since the legs are usually attached to the 
floating roof, the Up position of the legs allows the roof to descend to a lower level in the 
tank, and is the setting used in normal operation. The Down position causes the roof to 
become supported on its legs at a higher level and is the setting used for maintenance 
purposes. 

Where a tank has a floating roof with fixed or one - position legs, it is advisable to set the 
"Legs Up" and "Legs Down" levels to be the same so that the Leg Position selection becomes 
inconsequential.

Selection of Leg Position in the Multi Scan NXA83 has no effect on the actual position of the 
legs in the tank. The purpose of this field is to select the appropriate correction data for the 
leg position set within the tank.

Weight – The weight of the floating roof (including any attached legs). It is important that 
this figure is accurate as it will be used when calculating compensation for the displacement 
of the product by the weight of the roof.

Roof Floating Legs Down - The point at which the roof just ceases to be resting on its legs 
when the legs are in the "down" or maintenance position, such that the entire weight of the 
roof is being supported by its buoyancy in the product. Above this level, compensation is 
made for the displacement of the product by the full weight of the roof. 

Roof Support Legs Down - The point at which the roof legs are supporting the full weight 
of the roof when the legs are in the "down" or maintenance position. Below this level, no 
compensation is made for product displacement caused by roof weight. 

Roof Floating Legs Up - The point at which the roof just ceases to be resting on its legs when 
the legs are in the "up" or operational position, such that the entire weight of the roof is being 
supported by its buoyancy in the product. Above this level, compensation is made for the 
displacement of the product by the full weight of the roof.



Database Configuration Tankvision

54 Endress+Hauser

Roof Support Legs Up - The point at which the roof legs are supporting the full weight of 
the roof when the legs are in the "up" or operational position. Below this level, no 
compensation is made for product displacement caused by roof weight.

The area between the Fully Supported and Fully Floating levels is generally referred to as the 
roof transition zone. Between these levels it is difficult to determine the proportion of the 
roof's weight which is being held by the legs and therefore difficult to calculate the 
displacement of product by the roof. For this reason this region of the tank is normally 
avoided during normal operation.

Shell Correction

These settings are only relevant if you have enabled shell correction in Inventory Control 
Settings.

NXA83_Tank-Characteristics_Shell-Correction

Shell Insulation Factor – 1 for completely insulated storage, 0 for un-insulated storage, a 
typical value is 0.875.

Shell Expansion Coefficient – Expansion coefficient of the material the tank is constructed 
from, e.g. mild steel = 0.0000112.

Shell Reference Temperature – Normally the same reference temperature used for VCF 
calculations (typically either 15 °C or 30 °C).

Manual Air Temperature – Tick to enter the air temperature manually, do not tick if a 
gauge is fitted that can provide an automatic air temperature.

Miscellaneous

This section is provided for operators to note additional information about the tank. These 
are housekeeping features that do not affect the behavior of the system.
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NXA83_Tank-Characteristics_Miscellaneous

Inventory Settings

The settings on this page control the way the inventory calculations are performed. The 
default settings are modified by clicking on the arrow and selecting a new setting from list. 
A table of available settings is shown below.

NXA83_Tank-Characteristics_Inventory-Settings
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7.5 Tank Strapping Data Configuration

7.5.1 Tank Strapping Data Configuration Introduction

If the Multi Scan NXA83 is to be used to calculate tank inventory it will need to be configured 
with a strapping (Tank Capacity) table for each tank. 

Setting 1 Setting 2 Description

Gauge Levels are Innage Gauge Levels are Ullage The levels returned by the gauge are innage 
(referenced from the bottom) or ullage 
(referenced from the top)

Ullage Level zero = Max. 
Operating Level

Ullage Level zero = Reference 
Level

Zero ullage is taken as the highest safe working 
level or the maximum height of the tank

Gauge reads Reference 
Density

Gauge Reads Observed 
Density

Use this setting with care! When set the 
inventory calculator derives the reference 
density from the observed density information, 
if you enter manual densities be aware of 
whether you enter a reference density or an 
observed density.

Gauge Reads Density in 
Vacuum

Gauge Reads Density in Air When set an allowance for the density of air will 
made during inventory calculations.

Gauge Reads Absolute 
Pressure

Gauge Reads Relative 
Pressure

Internally pressures are stored in Bar absolute, 
checking this option will cause the pressure 
stored to be calculated from the gauged value.

Display Innage Level Display Ullage Level Causes levels displayed to be switched between 
innage and ullage.

Roof Weight Specified in Air Roof Weight Specified in 
Vacuum (mass)

If you know the mass of your floating roof, set to 
Roof Weight Specified in vacuum.

Tonnes/hour flow rate 
specified in Air

Tonnes/hour flow rate 
specified in Vacuum

Check this if you want a mass flow rate as 
opposed to a weight flow rate.

Disable tank shell correction Enable tank shell correction Select to perform tank shell correction 
calculation. Enter shell correction information 
on the relevant tab in this module.

No hydrometer correction in 
Vcf

Apply hydrometer correction 
to VCF

Set according to whether hydrometer correction 
is required or not.

WCF uses Table 56 
calculation

WCF uses fixed 0.0011 kg/l Select this to use a calculated WCF, which gives 
better accuracy when calculating WCF.

Use IP calculation of TOV/
GOV

Use API calculation of TOV/
GOV

Set if you wish to use American (US) style 
calculations, which perform the floating roof 
and free water corrections at a different stage to 
the British calculations.

No suspended sediment and 
water

Include suspended sediment 
and water

Set if you want include sediment and water 
correction in your inventory calculations.

No seperate sediment 
calculation

Seperate sediment and 
water calculations

Set to enable separate sediment and water 
correction calculations.

Water density 1.000 kg/l for 
fresh water

Water density 1.020 kg/l for 
sea water

Set according to whether the water you have in 
your tanks is fresh or sea water.

Tank calculated as 
hydrocarbon storage

Tank calculated as ballast/
slops storage

When set movements in and out of the tank are 
assumed to leave a constant oil depth and vary 
the amount of water in the tank.

Use vapour temperature in 
vapour correction

Use product temperature in 
vapour correction

Select temperature source for vapour correction 
calculations.

Average gauge temperature is 
product temperature

Average gauge temperature is 
vapour temperature

This option allows an Auxiliary Vapour 
temperature field to be used for a Product 
temperature gauge.
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The Tankvision Multi Scan Configurator software comes equipped with a Strapping table 
module that allows the user to load, remove, edit and display tank strapping tables. 

Each strapping table needs to be provided in a comma separated values (.csv) text file. The 
Strapping table module can extract the data from the text file and load it into the strapping 
table database. 

The accuracy of the volumes calculated by the Multi Scan NXA83 is only as good as the 
accuracy of the tank strapping points provided.
It is therefore recommend that care is taken when selecting the points for entry. Where 
possible the original tank strap points should be entered to achieve highest accuracy. 
The maximum number of points that can be entered is 3000.

If the original tank strap points are not available Endress+Hauser can deduce these points 
from the full calibration table. This is made substantially easier if the tank calibration data 
is available on disk in a spreadsheet format.

7.5.2 Using the Strapping Table Utility

The strapping table utility is accessed by selecting Configuration → Strap Tables from the 
Tankvision Multi Scan Configurator window.

7.5.3 Loading the Strapping Table Module

Select Configuration → Strap Tables from the Tankvision Multi Scan Configurator window. 
The Strapping Table module, below, will be loaded.

NXA83_Strapping-Chart

7.5.4 Adding a New Strapping Table

Select Table → New from the menu bar. Enter a Tank ID and click OK.
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NXA83_Strapping-Chart_New-Strapping-Table

A new screen will be displayed with options for creating strapping points in the new table.

NXA83_Strapping-Chart_Create-new

If a file containing the strapping table is available in comma separated values (.csv) format 
select Import Strapping Table. Browse for the file location in the next window, select the 
file and click Open.

NXA83_Strapping-Chart_Import-Strapping-Table

If no file is available select Create new strapping table. This will enable manual entry of 
strapping data in the screen editor table to the Left of the Strapping Chart. A new line is 
automatically added to the end of the table when the last line is populated. As values are 
entered into the table they are simultaneously plotted onto the Strapping Chart. This is a 
useful aid to spot any erroneous data. The plotted characteristic should be almost linear for 
Vertical Cylindrical tanks. Lines can be Added or Deleted from the table by Right Clicking on 
the start of the line at the point in the table where a line is to be Added/Deleted.
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Strapping Data may be entered at a later date; in this case select Leave it for now.

When the strapping table is complete, save the changes to the database by clicking on the 
 button.

The Strapping Table Module can be closed by selecting Table → Exit or by clicking on the 
 button.

7.5.5 Viewing Existing Tables

Load the Strapping table module as described in the previous section.

Select the table to be viewed from the drop down Tank Id menu. 

NXA83_Strapping-Chart

If the strapping table has been created, the data values are displayed as a list on the Left and 
plotted as a graph on the Right, as in the example above. The characteristics of the graph are 
useful for spotting erroneous data.

If the selected tank has no strapping table you will be prompted with the Strapping Chart 
dialog box as if creating a new table.

7.5.6 Editing Values in an Existing Strapping Table

Start the Strapping Table configuration module.

Select the tank for which the strapping table is to be edited. The table will be populated 
with the existing data.

Select the item to be edited.

Type a new value and move off the row to save the changes locally to the table.

To save the changes to the database press the Save button .

If the Exit button is used prior to pressing the Save button, you will be prompted to save 
the data.

4.

5.

6.
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Inserting an Extra Row

Select the row at which a record needs to be inserted by clicking with the left mouse 
button the left hand side of the row.

Right click and select Insert from the pop-up menu. 
A new row will be inserted above the selected row.

Enter Level and Volume for the new row.

NXA83_Strapping-Chart_Insert-Row

Repeat the above procedure if more rows are to be added. When finished click on  to 
save the changes to the database. The Multi Scan NXA83 will automatically arrange the 
rows in order of ascending Level. 

If an invalid entry has been mare in a row the following box will pop up, prompting the user 
to review the table.

NXA83_Strapping-Chart_Error

Deleting Rows

Select the row which needs to be deleted by clicking with the left mouse button at the 
left hand side of the row.

Right click and select Delete from the pop-up menu. The row will be deleted.

To save the changes to the database press the  button.

4.
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7.5.7 Validity of Data

The Tankvision Multi Scan Configurator software attempts to check the validity of the data 
entered when the user presses the Save button.

For example, all data entered into the Level column has to be in ascending order of 
magnitude. Also no two rows may contain the same value for level.

7.6 Alarm Configuration

7.6.1 Alarm Configuration

An integrated part of the Tankvision Multi Scan Configurator application is the Alarm 
Configuration module.

This module provides the user with a multi-tabbed data entry display for the entry and 
configuration of programmable alarms. 

A wide range of programmable alarms have been provided with the Multi Scan NXA83 to 
ensure that the operator/user has sufficient control over product movement. 

All the alarms are organized into logical groups each being assigned a different tab within 
the display.

The main alarm groups are:
� Movement Alarms
� Gauge Alarms
� Programmable Level Alarms
� Programmable Temperature Alarms
� Miscellaneous Alarms

The alarm configuration module is launched by selecting the appropriate tool bar button.

7.6.2 Launching Alarm Configuration

Select the Alarm Configuration option from the Configuration menu. The following 
display is typical:

NXA83_Alarm-Configuration
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Expand the Tank to show the different types of alarms that can be configured. Select one of 
the alarm groups.

Movement Alarms

NXA83_Alarm-Configuration_Use-Smoothing-for-Movement-Alarms

Use Smoothing for Movement Alarms – Tick this box to apply smoothing to the volume 
used to test for the Unauthorised Movement Alarm and the Theft Alarm. The smoothing 
uses the same parameters entered for the flow calculations, i.e. Flow Rate Damping and Flow 
Rate Integration. These are entered in the Gauge Configuration screens.

Theft Alarm

This option is currently not supported.

Unauthorised Movement Alarm

This alarm is often referred to as a Leak Alarm although it applies equally to a gain or a loss 
of product. The Multi Scan NXA83 refers to these as unauthorized movements.

NXA83_Alarm-Configuration_Unauthorised-Movement-Alarm

The unauthorized movement alarm is intended to protect against inadvertent movement of 
product in static tanks. This alarm should be enabled when the tank is to remain static. The 
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current GSV for the tank is stored when the alarm is enabled. If the GSV in the tank change 
beyond the specified threshold limit the alarm will be triggered. The alarm should be 
disabled when performing authorized movement of product into or out of the tank.

Threshold – The volume of product by which the GSV must vary before an Unauthorized 
Movement alarm will be raised.

Flow Alarms

NXA83_Alarm-Configuration_Flow-Alarms

The flow alarms are intended for use when tanks are moving. They are useful to detect that 
flow has exceeded a tank or pipeline design limit or that flow has reduced or stopped perhaps 
due to some fault.

The high flow alarm will be generated when the current calculated flow rate exceeds the 
High Flow Alarm limit and where the flow is positive (i.e. into the tank), the product level 
is above the Rising Hold Off, or where the flow is negative (i.e. out of the tank), the product 
level is below the Falling Hold Off.

� Enabled – Tick the box to enable the Flow Alarms.
� High Flow Alarm – The maximum allowable flow rate before High Flow Alarm is 

triggered.
� Low Flow Alarm - The minimum allowable flow rate before Low Flow Alarm is triggered.
� Hysteresis – The amount a flow rate needs to change beyond the setpoint to cancel an 

alarm.
� Rising Hold Off – The High Flow alarm will not be generated below this product level 

when the tank is filling.
� Falling Hold Off - The Low Flow alarm will not be generated above this product level when 

the tank is emptying.



Database Configuration Tankvision

64 Endress+Hauser

Gauge Alarms

NXA83_Alarm-Configuration_Gauge-Alarms

Gauge alarms are generated by the gauging instrument. The alarm levels displayed on this 
screen are for reference purposes only.

On some modern technology gauges it is possible to read the gauge alarm settings from the 
gauge automatically. On older gauges where this is not possible, provision is made to enter 
the Gauge alarm values manually.

Since the tankgauging software does not set the Gauge alarm levels, detection of gauge 
alarms is determined by the gauging instrument. The Multi Scan NXA83 reads the 
status of the alarm bits transmitted to it by the gauge and if necessary raises an alarm.

Gauge alarm levels are normally set by the gauge commissioning engineer.
� Gauge Alarm High High: The gauge high high level alarm setting
� Gauge Alarm High: The gauge high level alarm setting
� Gauge Alarm Low: The gauge low level alarm setting
� Gauge Alarm Low Low: The gauge low low level alarm setting

Programmable Variable Alarm

NXA83_Alarm-Configuration_Programmable-Variable-Alarm
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The Programmable Variable Alarm is used to trigger an alarm when the level gets above or 
below a set point, dependent upon the direction of flow.

The programmable variable alarm is an additional level alarm provided for use on moving 
tanks, it incorporates a configurable "advanced warning" alarm to indicate that product level 
is nearing the alarm level set point.

The user configurable fields are:

� Enabled – Tick the box to enable the alarms.
� Level – The point at which the level alarm is triggered.
� Hysteresis – Amount by which Level must fall/rise (dependent upon flow direction) to 

cancel alarm.
� Time To Target – Amount of advanced warning before level alarm point will be reached. 

The remaining time is calculated from the flow rate and an alarm will be raised at the 
specified time.

� Time To Target Hysteresis – A hysteresis value to compensate for fluctuations in flow 
rate.

� Direction – Alarms are dependent upon flow direction. Set the arrow to indicate the 
direction of flow; Up for Receipts (tank filling) and Down for Loading (tank emptying). 
Double click on the arrow to toggle direction.

� No Flow Volume – An alarm is raised if the Volume flow rate falls below the value entered 
here.

� No Flow Cons. Time – The "Consideration" time for the No Flow Volume alarm. When a 
movement starts no alarm will be raised for the period specified to allow the flow rate to 
stabilize.

Programmable Level Alarms

NXA83_Alarm-Configuration_Programmable-Level-Alarms

Programmable level alarms are triggered by the level returned from the gauge. They can be 
used where hardware alarms are not available or used in addition to the gauge hardware 
alarms.

The programmable level alarms have equivalent gauge level alarms. The programmable 
alarms would normally be used as early warnings to the gauge alarms and would be set 
slightly below (high alarms) and slightly above (low alarms) their respective gauge alarm 
values.
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The configurable fields are:

� Enabled – Tick the box to enable the alarms.
� High High – Enter a value for the High High level alarm.
� High - Enter a value for the High level alarm.
� Low - Enter a value for the Low level alarm.
� Low Low - Enter a value for the Low Low level alarm.
� Hysteresis – Enter a value to compensate for minor fluctuations in level.

The term High High is normally associated with the extreme upper limit to which a tank 
would be filled. Under normal operating conditions it would be unusual to trigger this alarm. 
This will raise a severity "Critical" alarm.

The term High is not as extreme as High High and is normally set a small distance below the 
High High limit. This will raise a severity "High" alarm.

The term Low Low is normally associated with the extreme lower limit to which a tank 
would be emptied. Under normal operating conditions it would be unusual to trigger this 
alarm. This will raise a severity "Critical" alarm.

The term Low is not as extreme as Low Low and is normally set a small distance above the 
Low Low limit. This will raise a severity "High" alarm.

The programmable level alarms can be configured to alarm for any purpose, the only 
stipulation is that they must be configured in level order (i.e. a Low alarm may not be set 
higher than a High alarm) however it is recommended that they are used within the context 
of the definition of the alarm to avoid confusion.

Programmable Temperature Alarms

NXA83_Alarm-Configuration_Programmable-Temperature-Alarms

Programmable Temperature alarms are triggered by the temperature returned from the 
gauge.

The configurable fields are:
� Enabled – Tick to enable alarm.
� High – Set a temperature to trigger a High temperature alarm.
� Low - Set a temperature to trigger a Low temperature alarm.
� Hysteresis - Enter a value to compensate for minor fluctuations in temperature.



Tankvision Database Configuration

Endress+Hauser 67

Programmable Water Alarms

NXA83_Alarm-Configuration_Programmable-Water-Alarms

Water alarms are triggered when tank water levels exceed the specified limits. The water 
level can be returned from a Water dip using a Level gauge or from a dedicated water level 
gauge.

The configurable fields are: 
� Enabled – Tick the box to enable the alarms.
� High - The free water level, above which the alarm will be triggered.
� Low - The free water level, below which the alarm will be triggered. The Low level water 

alarm may be disabled by configuring a negative set point.
� Hysteresis – Enter a value to compensate for minor fluctuations in level.

Difference Alarms

NXA83_Alarm-Configuration_Difference-Alarm

For applications where an accurate product level measurement is critical a tank may have 2 
level gauges. One gauge will be nominated as Primary duty with the other as a Secondary 
gauge.
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The Multi Scan NXA83 will monitor the level returned from both gauges and can check for 
a difference between the two gauge levels. If the difference exceeds the tolerance entered 
for this alarm a difference alarm will be generated.

The configurable fields are:
� Enabled – Tick to enable the alarm.
� Allowable Tolerance – Enter the maximum allowable difference between the 2 gauge 

levels.
� Hysteresis – Enter the value required for hysteresis.

Deviation Alarms

NXA83_Alarm-Configuration_Deviation-Alarm

The deviation alarm is used to alert operators to layering occurring within a tank. When two 
consecutive profile points deviate by the specified amount, in their density readings or 
temperature, an alarm will be generated. This alarm requires the use of gauges capable of 
returning density profiles.

The configurable fields are:
� Enabled – Tick to enable the alarm.
� Density Profile Deviance – Enter the maximum permissible difference between 

consecutive density points.
� Temperature Profile Deviance - Enter the maximum permissible difference between 

consecutive density points.
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Programmable Density Alarms

NXA83_Alarm-Configuration_Programmable-Density-Alarms

These are operator programmable density alarms.

The configurable fields are:
� Enabled – Tick to enable the alarm.
� High – Enter a value for the maximum permissible observed density.
� Low - Enter a value for the minimum permissible observed density.
� Hysteresis – Enter a hysteresis value for density measurement alarms.

Floating Roof Alarm

NXA83_Alarm-Configuration_Floating-Roof-Alarm

Under normal operating conditions this is generally undesirable for a floating roof to rest 
upon its legs. The Floating Roof alarm provides the option of generating a warning when the 
product level is approaching the point where the roof starts to rest on its legs.

When enabled, the Floating Roof Alarm will be activated when the product level falls below 
the Roof Early Warning Level. The alarm will be cleared when the product level rises above 
the Roof Early Warning Level by more than the Roof Warning Hysteresis.

� Enabled – Tick to enable.
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� Roof Early Warning – Enter the level where the alarm will be generated. The level would 
normally be programmed above the Roof Fully Floating level set in the Tank 
Characteristics module.

� Roof Warning Hysteresis – Enter the distance by which the product level must return 
above the Roof Early Warning Level in order to clear the Roof Early Warning Alarm.

User Defined Alarms (Programmable)

NXA83_Alarm-Configuration_User-Defined-Alarm

User Defined Alarms are a set of additional Programmable alarms. There is a choice of 24 
alarm types selectable from the drop down menu. These are simplified alarms with only a 
setpoint and hysteresis that can be configured. The units for the entry fields are 
automatically set when the type of alarm is selected. There is a Description field to enter text 
which will be displayed in the Alarm Event Viewer when the alarm is triggered. There are 
eight User Defined Alarms available.

NXA83_Alarm-Configuration_User-Defined-Alarm_Level-High
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7.6.3 Modifying Data Within Alarm Configuration

Open the Alarm Configuration window and select the tank from the list on the left. 
Select the type of alarm to be modified for this tank.
N.B. all alarms are tank specific. If the same alarms are required for more than 1 tank, 
they will need to be configured for each tank.
The current details for the alarm for that tank will be displayed.
The Multi Scan NXA83 comes supplied with a set of default alarm parameters pre-
configured. The first time Alarm Configuration is loaded after installing the system it 
will display the default values. These default values should be replaced with the correct 
operating values prior to commissioning the system.

Select the field to be edited and enter the new data values. The TAB key may be used to 
move to the next entry field or selection can be made using the mouse.
Each field is validated both during data entry and just before the data is saved to the 
database.

Once the changes are complete and correct, they can be saved by clicking the OK button. 
This will save the changes and close the window. To save the changes and continue to 
edit the database click the Apply button. It is not necessary to save the changes to one 
alarm before editing another but it is best practice to do so.

To edit further tanks follow the same procedure.

When all necessary configuration has been completed, the changes can be saved and the 
Alarm Configuration window closed by clicking the OK button. The window can be 
closed and changes can be abandoned without saving by clicking  or the Cancel 
button, however any changes already saved will be retained.

7.6.4 Generation of Alarms

Normally in a standalone configuration the alarms are detected and generated by the Data 
Communications Control module. It is this module that sees the changes in gauge data first. 

In a client-server system it is the same module that detects and reports the alarms although 
it is important to note that this module will only be running on the server. 

Any client connected to the server will therefore see the same alarms. 

Some events may be generated locally by each client. These are normally events in response 
to abnormal operating data or transient or irrecoverable data access errors.

7.6.5 Enabling and Disabling Alarms

When an alarm is Enabled, the variable associated with the alarm is monitored against its 
set limits. If the variable deviates outside of the set limits an alarm will be generated.

When an alarm is Disabled, no alarm processing will take place for the disabled alarm and 
therefore no event, audible signal or otherwise will be generated if the variable deviates 
outside of its set limits.

The alarm configuration display provides a check box within each tab for enabling or 
disabling the alarm.

7.7 Manual Data

Normally tank data is collected from the field instruments automatically.

Where primary data values are not available or no longer available due to a gauge fault, data 
values may be switched from automatic mode to manual mode.
When in manual mode the data values must be provided by the operator.

4.

5.
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Data that is in manual mode is normally displayed with green text on black background to 
signify that it is manual data. On reports it is normally suffixed with the letter M. 

Where tanks are not fitted with gauges but are still required on the system, the tank may be 
operated with all of its primary data values in manual mode. In this way the tank inventory 
is calculated from the manual data. Note that gauges that have both level and temperature 
in manual mode will not be polled by the communications layer.

Primary data values are those measurements made by the tank gauging instrument such as:
� Product Level
� Water Level
� Product Temperature
� Product Density
� Pressure

Traditionally, most gauges provide Product Level and Product Temperature measurement 
capability. It is quite common to find that the rest are entered as manual data. 

More modern gauging instruments have the capability to measure water level, density and 
pressure automatically. In this case the values would be collected automatically. 

The use of this feature can be controlled by the security system.

7.7.1 Launching the Manual Data Entry Module

In order to enter Edit mode and modify manual data values users must be logged on with the 
correct access rights. To access manual data configuration from the main application 
window menu, select Configuration → Manual Data.

The following display is typical of what will be loaded.

NXA83_Manual-Data

A list of all tanks will be displayed on the left, together with the manual data entry fields for 
the selected tank. 
By default a reduced set of the most common fields will be displayed.

To view the additional fields for a tank click on the advanced button  .



Tankvision Database Configuration

Endress+Hauser 73

NXA83_Manual-Data_Additional-Fields

By default any changes to the manual data for a tank will apply to ALL gauges on that tank.

The individual gauges assigned to a tank can be viewed and edited by clicking on the 
ShowHide_gauges button .

NXA83_Manual-Data_Individual-Gauges
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In this mode the manual data can be configured for individual gauges.

7.7.2 Entering Manual Data

Select a tank/gauge from the list and edit the required parameter. 

If the field is not already in manual mode tick the Enabled box at the start of the line.

After all required data has been entered; Click on the OK button to save the changes to the 
database and exit the application. Click on Apply to save the changes and continue editing.

Click on the Cancel button to discard any changes and exit the application.

7.8 W&M Calibration

Weights and Measures (W&M) approved Multi Scan NXA83 are required to display the 
approval status of all parameters displayed on screen. Data for tanks that are not approved 
will be displayed with a ‘#’ symbol.

The W&M Calibration screen allows tanks to be marked as approved and also to mark the 
individual parameters on those tanks.

These parameters currently include:
� Product Level
� Product Temperature
� Water Level
� Density
� Vapour Pressure
� Vapour Temperature

In order to enter Edit mode and modify W&M calibration data users must be logged on with 
the correct access rights for Manual data entry. To start the calibration screen, select 
Configuration → W&M Calibrate.

NXA83_W&M-Calibration

In order to adjust the calibration status of a gauge, it must first be selected. Choose the tank 
containing the Gauge from the list on the left of the screen. Expand the tank and choose the 
gauge from those available. The individual calibration status boxes will be greyed out and 
marked as not calibrated (unticked) until the Tank Calibrated field is ticked. Once the Tank 
Calibrated field is ticked, the individual parameters may be ticked to show their calibration 
status.
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7.9 Product Configuration

When first installed the system has no product information.
This function is used to enter the names of the products stored on site.
Product Configuration can be launched at any time in order to edit existing products, delete 
products or to add new products.

Each product must be allocated to a product group. By default, a GENERAL product group 
exists. Other Groups may be created as required. 

7.9.1 Product Groups

Product Groups allow the user to group together products that have similar characteristics.

For example, Product Groups might be configured as:
� DISTILLATES
� SPIRITS
� CRUDE
� HEAVY OILS
� FUEL OIL

The following products may for example be members of the DISTILLATES product group:
� DERV
� KERO
� GAS
� OIL
� JET A1

Similarly, the following products may be members of the SPIRITS product group:
� ULMS
� LRP
� UL 95
� UL 98

And so on.

7.9.2 Launching Product Configuration

Select the Product Configuration option from the Configuration menu. 

The following display is typical:
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NXA83_Product-Configuration

Enter the product groups as required. 

To enter a new Product Group:

Click the Product Group toolbar button .

Enter the name of the new product group.

Click the Apply button to save the new group to the database.

To edit an existing group:

Select the group to be edited.

Modify the Group name.

Click the Apply button to save the changes to the database.

To delete an existing group:

You can only delete a group when it contains no products.

Select the group to be deleted.

Click the Delete button .

Click the Apply button to confirm delete.

Click the Cancel button to abort the delete.

To enter a new product:

4.
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NXA83_Product-Configuration_New-Product

Select the Group where the New Product will be added.

Click the New Product button  on the tool bar.

Type the name of the new product. This field is limited to 30 characters.

Choose a new color. 
Note that the use of color is determined by options configured in the System Settings 
module. Please refer to a description of these settings for further information.

Click the Apply button.

The new product will be allocated to the selected group. To allocate the product to a tank, 
refer to details in the Tank Characteristics section (→ ä 49).

To delete an existing product:

If the selected product is currently in use, the Delete command will be rejected. You 
must remove all use of the selected product before it can be deleted.

Select an existing product. The current configuration details will be displayed.

Press the Delete button  on the toolbar. The product will be removed from the 
database.

Press the Cancel button to discard any changes.

7.9.3 Allocating Products to Tanks

The Tank Characteristics module is used to allocate a product to a tank. 

See the section detailing the Tank Characteristics module (→ ä 49) for a full and complete 
description.

4.

5.
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8 Display Configuration

8.1 Tank Data Displays

As an optional feature, the Tankvision Multi Scan NXA83 is equipped with a 7 in LCD 
touchscreen display which is used to view the live data from any tanks configured in the 
database. Navigation around the different displays is by selection of the touchscreen 
buttons.

The display can show data to in a number of different formats:
� Grid View display of multiple tanks
� Single Tank graphical display
� Multi Tank graphical display
� Reports of multiple tanks

A range of different displays can exist for each type, which may be selected for viewing by 
the operator.

These displays must be configured in the Tankvision Multi Scan Configurator software 
before being downloaded to the NXA83 device. 

The configurator user is free to select from a range of data fields to display, such as level, 
temperature, density etc. Other features such as pictures, bar graphs, alarm displays, text 
label and selector buttons may also be displayed.

8.2 Display Configuration

The Multi Scan NXA83 has the capability to configure three categories of display:
� Single Tank Displays
� Multi Tank Displays
� GridView Displays

The first two use a SCADA editor to configure the displays. This makes them highly 
adaptable, enabling displays to be configured to exactly match user requirements. 

GridView displays are equally configurable but use a grid layout to display data. These will 
be covered in a later section (→ ä 92).

Various different displays can be configured.

To open the display editor open the Configuration menu and select the type of display to 
create or edit.
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NXA83_Configurator_Configuration_Displays

1 Three categories of display: Single Tank, Multi Tank, GridView

The display selection screen will be displayed for the type of display chosen, e.g.

NXA83_Configurator_Single-Tank-Overview

This will show a list of all currently configured displays. 

The text is the name that will be displayed in the menu on the Multi Scan NXA83 display 
screen. This can be changed when the display is edited.

The item in brackets is the actual name of the configuration file for the display, for instance 
(display.sto).

8.2.1 Adding a display

To add a new display:

Open the Configuration menu.

Pick the category of display required.

Click on the Add button. A new display editor will start.

1
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Configure the display as required.

When complete, save the display to a new file name.

A new item will be displayed in the list of displays.

8.2.2 Deleting a display

Once a display is deleted it cannot be restored, so be sure before deleting any display.

To delete the different types of displays:

Select the Configuration menu and pick the category of display required.

Select the display to be deleted and click on the Delete button.

8.2.3 Editing a display

To edit the different types of displays:

Select the Configuration menu.

Select the category of display required.

To edit a display select the item in the list and then click on Edit.

This will open the display editor for this file.

8.2.4 Setting the DEFAULT display

One display of each type will be marked with [DEFAULT SCREEN]. This is the display that 
will be initially loaded when the Multi Scan NXA83 boots up.

To change the default screen, select the new screen and click on the Set as Default button.

8.3 Single Tank and Multi Tank displays

The Multi Scan NXA83 single tank and multi tank displays are completely flexible for the 
data to be shown on the screen. They are configured using the Tankvision Multi Scan 
Configurator software.

A display may be configured for a range of items, including:
� Live Data Fields – For measured data such as Level, Temperature, Pressure, Density, 

Water Level etc. May also includes calculated data such as Volumes, Mass etc.
� Data Entry Fields – For manual data, alarm setpoints etc.
� Fixed Text Labels
� Bar graphs – showing percentage level etc.
� Pictures
� Alarms
� Graphs – For Multi-element temperatures, profiles etc.

Each field can be customized for size, color, fonts etc. 

Single Tank Displays only display data for gauges from a single tank name. The configured 
screen becomes a template for what to display, therefore display fields cannot be configured 
for a specific Tank and only the gauge duty may be specified. The tank is specified at runtime. 

Multi Tank Displays are fixed displays where data from multiple tanks can be displayed on 
the same screen. All display fields must have the tank name and duty defined at the time of 
configuration.

4.

5.
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8.3.1 Display Editor

The Single Tank/Multi Tank Display editor is started as described in previous section 
(Display Configuration).

NXA83_Display-Editor

The editor allows all displays items to be configured as required.

All items shown in the editor are configurable and the layout is free-form, therefore they 
may be placed anywhere on the screen. The following areas should however be avoided:
� Top right hand corner: The fixed Tanks selector button goes here in normal operation
� Top left hand corner: The fixed Screens selector button goes here in normal operation
� Bottom line: The status display field goes here
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NXA83_Display-Editor_Avoid

1 Area for fixed Screens selector button
2 Area for fixed Tanks selector button
3 Area for status display field

8.3.2 Modifying an existing item

To modify an existing item in the display, first click on the item.

NXA83_Display-Editor_Modifying-Existing-Item

The item can be moved around the screen by holding down the left mouse button and 
dragging it to the new location. 

The item can be re-sized by dragging the edge/corner to the new size. Certain items, such as 
pictures, can only be resized if the Stretch flag is enabled in its configuration menu.

To edit the configuration of an item right click on it, and select the option from the pop-up 
menu.

1 2

3
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NXA83_Display-Editor_Edit-Item

The options contained within the menu will depend on the display item being edited. On 
individual display items → ä 87.

8.3.3 Adding a new item

To add a new display item, right click on a blank section of the editor and select Add Item. 
Then select an item from the list.

NXA83_Display-Editor_Add-Item

The new item will be added to the top left corner of the editor and can now be modified as 
detailed above.
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NXA83_Display-Editor_Add-Item_Product-Level

8.3.4 Setting the Display Name

The display name is the text that will be displayed in the menu when selecting the display 
on the Multi Scan NXA83.

To set the name, right click on the background of the display (not on any field) and select 
Text from the pop-up menu. The Display name can be entered in the text box.

8.3.5 Changing the display units

The display units for all data items may be configured by right clicking on a blank section of 
the editor and selecting Units from the drop down menu.

NXA83_Display-Editor_Units
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NXA83_Display-Editor_Change-Dimensions

The units and number of decimal places for each data type may be configured and are then 
used in the Multi Scan NXA83 to format all live data in the display.

8.3.6 Changing the background color

The background color for the display may be configured by right clicking on a blank section 
of the editor and selecting the Back Colour menu option.

NXA83_Display-Editor_Back-Colour

The Select option allows the colour to be defined, or set to Use Default if the normal system 
background is to be used.

8.3.7 Copy, Paste & Select All

To copy an item, right click on the item and select Copy from the pop up menu.
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To paste an item that has been copied, right click on a blank section of the editor and select 
Paste from the pop up menu. The new item will be pasted into the top left corner of the 
editor and can now be modified as previously described.
Select All will select the entire contents of the editor. This is useful for performing global 
changes such as type font or item colour, or for duplicating large amounts of display data. To 
select all items, right click on an blank section of the editor and click Select All in the pop up 
menu.

8.3.8 Resize to fit

This command cannot be undone so it is recommended that a copy of the file is saved 
first.

When creating a display screen it may be desirable to eliminate any blank space around the 
edges of the screen. The Multi Scan NXA83 provides a tool to do this.
To resize the screen, cropping out all blank parts of the background to fit the current screen 
size right click on an blank section of the editor and select Resize to fit from the pop up 
menu.

8.3.9 Saving the display

To save the display configuration, either close the Display Editor or right click on a blank 
section of the editor and select Save from the menu.

NXA83_Display-Editor_Save-before-Exit

In both cases a pop-up window will appear prompting for confirmation to save the display. 
Click Yes to save or No to abandon any changes and exit.

The display is saved to a file of type .sto and the file name and destination can be specified. 
Although the file can be saved in any location, it must however be saved in the default 
Config folder for the Multi Scan NXA83 to access and use the file.
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NXA83_Display-Editor_Save-As

1 Safe as Screen: New file name

If a new file name is specified in the Save As screen (i.e. a new file name) then a new display 
will be added to the list of single tank displays. The changes will not have been saved in the 
original file.

NXA83_Display-Editor_Single-Tank-Overview

1 Single Tank Overview: New display

To overwrite an existing file, select the file from the Save As screen and click Save. A pop up 
window will appear prompting for confirmation to replace the existing file. Click Yes to 
proceed.

NXA83_Display-Editor_Save-As_Replace

8.3.10 Display Items

Display Items

The display may be configured with range of different items, including:
� Label: A fixed text field

1

1
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� Picture: A fixed picture displayed on the Multi Scan NXA83 screen
� Button: A link to run an executable program
� Command Button: A configurable shortcut to run a gauge command
� Group: A field used to group together a number of other items
� Data → Tank: A field used to display live data, specific to a single tank, from the Multi 

Scan NXA83. It is dynamic and will be refreshed periodically.
� Data → Product Totaliser: A field used to display live data, specific to a single product. 

The total amount is calculated from all tanks containing the specified product. It is 
dynamic and will be refreshed periodically. This field is only applicable to Multi Tank 
Overview (.mvo) displays.

� Flood: A simple vertical bar graph. The bar graph displays product level as a percentage of 
tank height. It is dynamic and will be refreshed periodically.

� Flood → Product Totaliser: A simple vertical bar graph that displays the total amount of 
a single product calculated from all tanks containing the product. The bar graph displays 
product level as a percentage of total capacity of all tanks containing the specified product. 
It is dynamic and will be refreshed periodically. This field is only applicable to Multi Tank 
Overview (.mvo) displays.

� Alarm: Displays an alarm icon on the screen when any alarm is active for the tank. If no 
alarm is active, the icon disappears.

� Tank Picture: This is the same as a picture except that a separate image can be specified 
for each of the four tank shapes. When a tank is selected, the picture displayed will be 
determined by the shape of the tank configured in the database.

� Valve: Not supported on the Multi Scan NXA83
� Pump: Not supported on the Multi Scan NXA83
� Data Entry: Similar to a data field except that instead of live data, data is entered bu the 

operator. This is useful for applications such as manual data (product level, temperature 
etc.) and setting alarm trigger points which cannot normally be altered whilst the Multi 
Scan NXA83 is live.

� Graph: A display item that shows live data in a graphical format. It is dynamic and will be 
refreshed periodically. Graphical data available is: Multi-element Temperatures, Skin 
Temperatures, Profile Temperatures, Profile Densities, IO Block Data

After adding a display item it must be configured for use. The attributes that can be 
configured depends upon the item and whether it is assigned to a Single or Multi tank 
display. To access the configuration attributes, right clicking the item in the display editor.
Below is a list of all configurable attributes.

Display Item Attributes

� Align: Aligns the text or picture within the item field to one of nine positions. The text/
picture can be located within the item box only.

� Arguments: Values to be passed to an executable program
� Color: Sub menu for item colour options. There are four possible options depending upon 

the item being configured:
– Transparent: Makes the label transparent so that only the text is visible
– Fore Color: Sets the text colour
– Back Color: Sets the Background colour
– Border Color: Sets the border colour for the display item

� Command: Used to specify the gauge command for command buttons
� Data: Used to specify the type of data, from a drop down menu, to be read into the display 

item. This can be live or manual depending upon the item. Data can be in 1 of 3 states 
Normal, Manual and Invalid. Each may be configured to have a different appearance for 
colour and alignment.

� Decimal Places: Specifies the number of decimal places to display
� Display: Sub menu used to select what characteristics are displayed within a data field. 

The following may be enabled:
– Show Operating Levels: Tick to display the tank operating levels on flood fields



Tankvision Display Configuration

Endress+Hauser 89

– Data: Tick to display the actual data value, otherwise no data will be displayed. This is 
normally ticked.

– Units: Tick to display units after the data value, otherwise no units will be displayed.
– Gauge Commands: Tick to show the gauge commands selector screen when the item is 

selected. If an item is in manual mode the manual entry screen will be displayed if this 
option is enabled.

– WM Status: Tick to display the Weights and Measures status of the data. This field is 
composed of a number of characters to show the current status of the data. Values 
include:
– ’&’ – data is manually entered
– ’S’ – data is stored, i.e. level when gauge is not following level etc.
– ’#’ – data is not W&M approved

– Default Decimal Places: Tick to format the data with the default decimal places for the 
units selected (to set default decimal places → ä 84)

� Executable: Select the executable program for button.
� Font: Used to set the font, size and style (bold, italic and underline) of the text
� Graph: Sub menu for the graphical display to set the following items:

– Show Grid: Tick to show the gridlines on the graph, otherwise none will be shown
– White Background: Tick to make the background of the graph white, otherwise it will 

be grey
– Minimum Range: Used to set the minimum range to be displayed on the x=axis of the 

graph
� Order: Sub menu. Items can be placed on the screen such that they overlap each other. The 

order that the items will be displayed is determined by pushing items to the back or pulling 
them to the front. There are no intermediate stages; items can only be sent to the back or 
to the front. Multi-layer ordering can be achieved by careful selection of the order that 
items are moved.
– To Front: Moves the selected item to the front of the group
– To Back: Moves the selected item to the back of the group

� Output Value: Defines the value to be passed to the specified data field when a command 
button is activated

� Picture: Opens a navigation window to select a picture to display
� Picture: Sub menu. This option is used for selecting and configuring pictures as 

backgrounds for buttons and labels. The following are configurable:
– Show: Tick to include a picture as a background
– Picture: Opens a navigation window to select a picture to display
– Align: Aligns the picture to one of nine positions within the button or label

� Product Name: Used to select a product from a drop down menu of configured products 
when setting data and flood totaliser fields

� Pump ID: This feature is not supported in the Multi Scan NXA83.
� Stretch: Unlike all other items pictures cannot be resized by "click and drag" of the picture 

field. Resizing the picture field will result in a white border (the field cannot be smaller 
than the picture). Ticking the stretch command will cause the picture to "Stretch" to fit the 
size of the picture field.

� Tank ID: In Multi tank displays (.mto) this is used to specify which tank and gauge duty is 
to be applied to an item. In Single tank displays (.sto) where there can only be one tank 
(specified at run time) this option is only used to specify the gauge duty.

� Text: This option opens a window for defining the text to be entered into items.
� Valve ID: This feature is not supported in the Multi Scan NXA83.
� Visibility: Sub menu. Items can be configured to only be visible under specific conditions. 

The options for configuring visibility are:
– Always visible: Tick this option to override visibility conditions. This option is selected 

by default.
– Tank ID: Select a tank and gauge duty, e.g. Tank1 primary gauge
– Data: Select a data value to test against, e.g. product level
– Test_Value: Set the condition that needs to be met to display the item, e.g. greater than 

5000
The example above could be used to display an alarm icon if the Product Level in Tank1 
exceeds 5000 mm.
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Item menus

NXA83_Display-Editor_Item-menus_Add-item

Label

NXA83_Display-Editor_Item-menus_Label

Picture

NXA83_Display-Editor_Item-menus_Picture

Button

NXA83_Display-Editor_Item-menus_Button
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Command Button

NXA83_Display-Editor_Item-menus_Command-Button

Group

NXA83_Display-Editor_Item-menus_Group

Data → Tank & Data → Product Totalizer

NXA83_Display-Editor_Item-menus_Data_Product-Totalizer

Flood → Tank & Flood → Product Totalizer

NXA83_Display-Editor_Item-menus_Flood_Product-Totalizer
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Alarm

NXA83_Display-Editor_Item-menus_Alarm

Tank, Valve and Pump

NXA83_Display-Editor_Item-menus_Tank-Valve-Pump

Data Entry

NXA83_Display-Editor_Item-menus_Data-Entry

8.4 Grid View and Reports

GridViews and Reports use a grid layout to display data either on screen or on paper (in the 
case of reports).

A range of Grid Views and Reports may be configured using the Tankvision Multi Scan 
Configurator tool, using a common set of configuration screens.

Reports may also be configured to be automatically printed at scheduled times. 

Grid Views and Reports are completely configurable. This makes the grids highly adaptable, 
enabling GridViews and Reports to be configured to exactly match user requirements.
Since GridViews are configured in exactly the same way as GridView Reports without the 
additional features of printing and report scheduling, this manual will only deal with 
GridView Reports.
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The grid can be customized for:
� the number of columns
� the tanks to be displayed
� column totals
� flow colours
� grid title text and font

Each column in the grid can be formatted for:
� Live Data such as Level, Temperature, Pressure, Density, Water etc.
� Width
� Font
� Header Text

A report may also be configured for print layout, including:
� Landscape/Portrait
� Margins

Various different Grid Views and Reports can be configured for a Multi Scan NXA83.

8.4.1 GridView Report Editor

To start the Grid View Reports editor select Configuration → GridView Reports 
(Configuration → GridView Displays for the display editor) from the Multi Scan NXA83 
configurator.

NXA83_Report-Configuration_GridView-Report-Editor

Select the report to edit or select Add to create a new GridView.
The report editor screen will open. The editor allows all parameters to be configured for the 
selected grid view report.
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NXA83_Report-Configuration

Configuration is split into three sections for GridViews plus an extra two for Reports:
� Grid: Sets global parameters for the grid, such as Caption, Fonts colors etc.
� Filter: Sets the criteria for selecting the tanks to be shown in the grid
� Report Printing: Sets report specific layout parameters, such as Landscape and Margins 

(Reports only)
� Report Scheduler: Sets automatic print parameters (Reports only)
� Columns: Sets the columns to be shown in the grid

To edit a section, select the relevant heading from the list on the left of the window. The 
appropriate data will be displayed in the right hand panel.

8.4.2 Grid

Click on the Grid item to edit parameters that affect the whole of the grid.

NXA83_Report-Configuration_Grid

The following parameters may be configured:
� Caption: This is the title for the report, displayed at the top of the screen. It is also the 

name used to select a report to be printed/displayed.
� Caption Font: Click on the Edit button to select the font to use for the caption.
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� Font: Click on the Edit button to select the font to be used for all data in the grid, including 
column header text.

� Totalise Columns: If ticked any volume, mass and weight column will be totalized and 
displayed at the bottom of the column. The text box to the right allows the row name to be 
entered. This defaults to "Totals" and will be displayed in any "Tank ID" column.

� Use Color: (Displays only)
� Use Color to Indicate Flow Direction: When ticked, rows in a grid will change color to 

indicate flow direction in moving tanks. The following colors are used: Brown to indicate 
an emptying tank and Blue to indicate a filling tank (Displays only).

� Use Color For Values in Alarm: When ticked, any values which are in a state of alarm will 
be shown on a Red background (Displays only).

� Units: Clicking on this item will display the units edit box. This allows the units of all data 
items to be set. The units only apply for this grid.

NXA83_Report-Configuration_Grid_Dimensions

8.4.3 Filter

Click on the Filter item to edit parameters that determine which tanks will be displayed in 
the grid.

NXA83_Report-Configuration_Filter
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The following parameters may be configured:
� Filter: This sets the mode to determine which tanks are displayed in the grid. Currently 

supported filter modes are:
– All Gauges: All tanks will be displayed in the grid, in the order that they appear in the 

database configuration.
– By tank ID: Only those tanks that are in the Devices list will be displayed in the grid.
– Product: Only those tanks that contain the product named in the Product field will be 

displayed in the grid, in the order that they appear in the database configuration.
� Product: If the Filter mode is Product, this field will be enabled to allow the product type 

to be entered.
� Primary Gauge: If ticked only Primary gauges will be included in the grid
� Devices: If the Filter mode is By tank ID, this section is enabled. A list of specific tanks can 

be entered for display in the grid. The order that tanks appear in this list is the order that 
they will be displayed in the grid.

Clicking on the Add Gauge button opens a window for selecting a tank to be included in the 
device list.

NXA83_Report-Configuration_Filter_Add-Gauge

Filtering by Tank ID only uses the Tank ID to determine what data to display. The Gauge 
Duty section is not used. If the Primary Gauge box is ticked only primary gauges will be 
displayed for the selected tanks, otherwise all gauges for these tanks will be displayed.

Click OK to add the tank. 
Clicking on the Delete Gauge button will delete the currently selected device.
Clicking on the Delete All button will delete all of the devices.

8.4.4 Report Printing

Click on the Report Printing item to edit parameters that determine how a report will be 
displayed on the printout.

NXA83_Report-Configuration_Report-Printing
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The following parameters may be configured:
� Landscape: If ticked the report is printed as Landscape, otherwise it will be printed as 

Portrait.
� Show Grid: If ticked the grid lines will be shown on the report.
� Center Grid: If this is ticked the report will be centred on the page.
� WM Approved: If ticked the report shows the weights and measures approval status of the 

Multi Scan NXA83.
� Margins: This section allows the margins for the printout to be defined.

8.4.5 Report Scheduling

Click on the Report Scheduler item to edit parameters that determine when a report will be 
automatically printed.

NXA83_Report-Configuration_Report-Scheduler

The following parameters may be configured:
� Mode: This sets the mode for print scheduling of the report. Choose from:

– None: The report will not be printed automatically. Manual printing is still possible
– Hourly Trigger: The Minutes field is enabled. The report will be printed every hour, at 

the specified Minutes past the hour.
– Daily Trigger: The Hours and Minutes fields are enabled. The report will be printed 

once per day, at the specified time.
– Weekly Trigger: The Day of Week, Hours and Minutes fields are enabled. The report 

will be printed once per week at the specified time.
� Day Of Week: This is a drop down menu for selecting a weekday.
� Hours: This is a dropdown menu for selecting an hour. The report scheduler uses the 24 

hour clock.
� Minutes: This is a dropdown menu for selecting minutes past the hour.

8.4.6 Columns

Click on the Columns item to edit parameters that determine what data columns will be 
displayed in the grid.
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NXA83_Report-Configuration_Columns

A representation of the grid will be displayed in the lower portion of the screen. This is the 
actual grid layout that will be displayed on the Multi Scan NXA83, but without the tank data 
rows.

To edit a column, click on that column in the grid display.

NXA83_Report-Configuration_Columns_Edit

The column in the grid display will be displayed with DN00 in red, to indicate that the 
column is selected. The panel above it will display the current parameters for that column.

Click on a field to edit its contents.

The following parameters may be configured for each column:
� Column Header Text: This is the text that will be displayed at the top of the column. Click 

within this field to edit the text using the keyboard.
� Data: This is the data field that will be displayed in the column. Click on the Edit button to 

display a pop-up window and select from the drop down menu.
� WM Status Column: If this box is ticked, the column will display the WM status characters 

for the selected data instead of the data.
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� Width: This field setsthe width in pixels for the column. Click within this field to edit the 
value using the keyboard. Any changes to this value will be immediately reflected in the 
grid. Note that the full width of the Multi Scan NXA83 display is 640 pixels.

� Align: This sets the alignment of the data in the column.

To insert a new column select a column in the grid next to where the new column is required 
and click on the Insert button. This will add an exact copy to the right of the selected column. 
The parameters may then be edited as required.

NXA83_Report-Configuration_Columns_Insert

1 Report Configuration Screen: Insert a new column

Columns can be removed by selecting the column and clicking the Delete button.

8.4.7 Saving the configuration

To save the configuration, close the window with the  button.

A prompt will appear asking if the configuration is to be saved.

NXA83_Report-Configuration_Columns_Exit-Prompt

Click No, to discard any changes and exit, or Yes to display the Save As dialog.

1



Display Configuration Tankvision

100 Endress+Hauser

NXA83_Report-Configuration_Columns_Save-As

A GridView will be saved to a file type of .gvo, whilst a report is saved to a file of type .gvr 
and the file name and destination can be specified. 

To function on the Multi Scan NXA83, the file must be stored in the Config folder.

Click Save to permanently save the new configuration. 

If a new file name is specified, the configuration data will be saved to the new file and a new 
screen will be added to the list of gridviews or reports. The original file will not be changed.
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9 System Settings

9.1 System Settings

System Settings are options and settings that affect the operation of the entire Multi Scan 
NXA83 system. The System Settings screen is available under the Admin menu.

The options that can be configured within System Settings are:
� Login Enabled
� Sound Enabled
� Voice Enabled
� Use Product Colours
� Movement Threshold

9.2 Using System Settings

Select the Admin → System Settings option from the main menu bar. 
The System Settings display will be loaded.

NXA83_System-Settings

To change any system settings you must be logged on as a user with administrative 
privileges.

To change System Settings:

Either tick/untick a box or enter the required value into the field.

Click on the OK button to close the window and save the changes to the database or the 
Cancel button to abandon the changes and exit.

9.3 Login Enabled

Determines whether users are required to enter passwords to access and modify the system.

If this option is ticked the Multi Scan NXA83 will require users to log in to access password 
protected controls. If users are not logged in, or do not have sufficient access rights the 
following dialog will pop up.

NXA83_System-Settings_Insufficient-user-rights

If this occurs click OK and log in with sufficient rights to continue.
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If log in is not enabled, there will be no access restrictions.

9.4 Sound Enabled

This determines whether sound is enabled. Currently only voice messages are supported by 
this feature. To enable this feature, tick the box.

9.5 Voice Enabled

This determines whether voice messages are enabled.

If this option is ticked the voice messages, where available, will be played for the alarms and 
warning that occur as part of normal tank gauging operations.

9.6 Use Product Colors

This determines the strategy for colour in the tank flood panes.

Currently the Multi Scan NXA83 does not support this feature.

When ticked the color representing the product level in the tank will be Blue.

When not ticked the colour of the product is represented by the tank status. For example, if 
the tank is filling, the color of the product is displayed as Blue; if the tank is emptying, the 
color of the product is displayed as Brown; and if the tank is static, the color is displayed as 
Green.

9.7 Movement Threshold

This determines the minimum flow rate level that is deemed significant enough to mark a 
tank as moving.

A default flow rate of 5 mm/min is considered adequate for most Multi Scan NXA83 
installations; however any user defined value may be entered.
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10 Security

10.1 Security

The Tankvision Multi Scan Configurator software is provided with its own security and user 
administration functions. It is not dependent on Windows system security for access to its 
features. 

The security database is stored for each Multi Scan NXA83 device and loaded when a project 
is loaded. 

The User Configuration module is present in the Admin menu. 

The security features should be used carefully to ensure users have the correct access rights 
for their tasks and to prevent unauthorized access to the system. 

To logon as a user select Security → Login.

NXA83_Security-Login

The Login screen allows the User name and Password to be entered. 

To log off from the current user then select Security → Logout.

10.2 Using Security Configuration

Log on to Tankvision Multi Scan Configurator software as an administrator.

Select the User Configuration option from the Admin menu.

The default security display will be loaded.
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NXA83_User-Configuration

All the current user details will be listed in a tabular form.

After installing the software only one account will exist. This is the Administrator account 
and it will have a default password of "password". It is recommended that this is changed to 
a more secure password as soon as possible.

The table is a matrix of users against their logon rights. The columns indicate the 
characteristics of the users account, and the rows represent the different users. It is therefore 
possible to deny or grant a level of access on a per feature basis (i.e. User A may be denied 
access to the Tank Characteristics module, User B may be granted Read Only access, and User 
C may have modify privileges).

The fields are defined as follows:
� User Name: Text entry field for user’s name. This will be displayed on the Home Page 

when the user is logged on.
� User Initials: Optional text entry field for an abbreviated version of the user name. This is 

a reference only field that is not used by the Multi Scan NXA83.
� User Group: Text entry field for the group a user belongs to. This is a reference only field 

that is not used by the Multi Scan NXA83.
� Password: Text entry field for the password of the user.
� Login Timer Enabled: Determines whether the user account will time out after a period 

of inactivity.
� Login Timer Timeout Time: The time of inactivity required before the user account times 

out and the user is logged out.

The remaining columns each reflect a feature or function within the Tankvision Multi Scan 
Configurator software. Each cell has a drop down menu to select the level of access a user is 
permitted for that feature.

The following access levels are currently available for each feature:
� No Access
� Read only



Tankvision Security

Endress+Hauser 105

� Modify
� Create
� Delete
� Full Access

The following software buttons are provided:

10.3 Creating a new User Account

Log on with sufficient access rights. Select Admin → User Configuration from the main 
menu bar.

Click the New button. A new row will be added to the table.

Use the mouse and cursor keys to configure the rights of the new user.

NXA83_User-Configuration_Adding-New-User

The following data entry fields are mandatory:
� User name (maximum of 20 characters)
� Password (minimum of 6 characters)

All the feature access rights will default to No Access if nothing else is specified.

Button Function

Edit Click to edit existing user accounts.

New Click to create New user accounts.

Copy Click to copy an existing user account.

Delete Click to delete an existing user account.

Cancel Click to abandon any changes.

OK Click to confirm changes.

Exit Click to close the display.
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Various different users can be added to a system.

To specify user rights for each feature scroll to the relevant column and select from the 
drop down menu.

Alternatively, an existing user account can be copied to create 1 or more new accounts.
Select an account by clicking the start of the row and click the Copy button.

NXA83_User-Configuration_Copy

A dialogue box will open requesting the number of copies required.

NXA83_User-Configuration_Copy_Number-of-copies

Enter the number of copies and click OK. These will be added to the bottom of the grid and 
will contain exact copies of the selected user’s access rights. The first 4 fields are User 
specific so are left blank to be completed with unique details.

The OK button will be enabled when any changes have been made to the configuration. 
To save the new user account to the database, click the OK button.
Provided all fields are supplied in the correct format, the data will be saved to the 
database. Any problem occurring whilst the data is being saved will be reported to the 
user via the display’s status bar shown below.

4.

5.
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NXA83_User-Configuration_Password-length

1 User Configuration Screen: Status bar

To cancel the changes click the Cancel button. 

To exit the display without saving changes click the Exit button. This will return you to the 
previous display.

10.4 Deleting an existing User Account

Log on with sufficient access rights. Select Admin → User Configuration from the main 
menu bar.

Select the account to be deleted by clicking the start of the row.
It is possible to delete multiple accounts. Select the rows to be deleted whilst holding 
down the CONTROL key. Each will be highlighted in turn.

1
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NXA83_User-Configuration_Deleting-User

Click the Delete button, a message will be displayed indicating how many rows are to be 
deleted.

NXA83_User-Configuration_Confirm-Delete-Multiple

To confirm deletion click Yes otherwise click No.

10.5 Editing an Existing User Account

Select Admin → User Configuration from the main menu bar.

Click the Edit button.

Navigate to the row and column to be edited and modify its contents.

4.
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NXA83_User-Configuration_Edit

Click the OK button to save the changes.

10.6 Forgetting Your Password

Your system administrator or anybody having administrative privileges can reset your 
password if you have forgotten your details.

4.
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11 Gauge Command Scheduler

11.1 Gauge Command Scheduler

The Gauge Command Scheduler is a Windows service that can be configured to send gauge 
commands at a specific time of day on a recurring basis.

The Gauge Commands can be sent to a Single Tank, all Tanks, or a group of tanks generally 
specified by Gauge Type. 

Care should be exercised when scheduling gauge commands, particularly those that affect a 
gauge’s primary measuring capability, as the tank may be involved in some sort of critical 
operation such as receiving product from a ship or similar. 

The Gauge Command Scheduler can be configured via the Tankvision Multi Scan 
Configurator tools.

11.2 Configuring Scheduled Commands

From the main page window, select the Tools → Command Scheduler Configuration menu 
item.
This will bring up the configuration application, which you can use tocreate, view and edit 
the scheduled commands.

NXA83_Gauge-Command-Service-Config

Command Schedule entries are listed on the left of the window, selecting one of these will 
display the details of the entry in the controls on the right.

Entry Details

Destination Denotes the way the gauges can be selected for scheduled item, either by a 
specific Tank ID, or collectively by Product or by Gauge Type.

Gauge Duty Where tanks are fitted with more than one gauge, this option is used to specify 
which gauge on the tank is to perform the command.
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When changes have been made to the schedule's detail, click Save to commit the changes to 
the database, or Cancel to discard them.
 
To create a schedule click New and edit the schedule as required. When the Save button is 
clicked this will add a new entry to the list on the left.
 
To change a schedule, select the schedule from the list on the left and click the Edit button. 
Changes saved now will overwrite the existing schedule.

To delete a schedule, select the schedule from the list on the left and click on the Delete 
button.

The Command Scheduler may be closed without saving changes by clicking the Exit button.

Command This is used to select the command to be executed by the gauge or gauges.

Custom Command If selected in the Command field this section is enabled to allow a custom 
command to be configured. Note that all the commands you can execute via the 
Multi Scan NXA83 are available from the Command list.

Schedule A scheduled command can be configured to send a single command once a day 
by ticking the Specified start box and entering a time into the field below. 
Commands can be sent at regular intervals by ticking the Command interval 
box and entering the interval period in the field below. 
It is also possible to execute a command between two specified times and a 
specified frequency by ticking the Specified start, Specified stop time and 
Command interval boxes. 
For example, to send a command every hour between the hours of 01:00 and 
04:00 you would set the start time as 01:00, the stop time 04:00 and the 
interval as 01:00.

Entry Details
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12 Advanced Features

12.1 Advanced Features

There are a number of menu items within the Tankvision Multi Scan Configurator that allow 
advanced access to the Multi Scan NXA83 and its directories. 

These are located in the Admin menu and comprise:
� System Folder
� Remote System Folder
� Remote System Login

All these features should be used with extreme care, and only by fully trained users.

For further details on advanced features → ä 10.
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13 Gauge Commands and Remote Configuration
The Gauge Commands utility allows commands and configuration items to be sent directly 
to any gauges attached to the Multi Scan NXA83. This requires a remote PC connection to 
the Multi Scan NXA83 and the gauges to be connected and communicating with the NXA83.

It also requires the Multi Scan NXA83 database to have been imported from device and 
selected as the current open project.

13.1 Launching Gauge Commands

From the Tankvision Multi Scan Configurator window, select Tools → Gauge Commands 
and remote Configuration.

Where a tank has more than one gauge, the application will default to the primary gauge for 
the selected tank. Users can subsequently select an alternative gauge to operate on by 
clicking  next to the tank and selecting the gauge duty.

NXA83_Gauge-Command

The appropriate set of options will be displayed for the gauge type.

13.2 Sending a Command

Select the tank from the list in the left hand panel. Expand the tank with the  symbol 
(select the gauge in a multi-gauge setup).

The commands supported by the gauge will be enabled.
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NXA83_Gauge-Command_Gauge-Items

Select the appropriate command from the list.

Set any required parameters and click the action button (dependent upon the command, 
Execute, Dip etc.).

Generally feedback and status of the command will be reported back to the user via the panel 
at the bottom of the window.
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NXA83_Gauge-Command_Gauge-Items_HA

13.3 Enraf Gauge Commands

Enraf gauges support the following functions:
� Gauge Items is a general tool allowing the user to read or write any of the gauge items and 

view the returned data and or responses.
� Maintenance allows the user to set the reference level of the gauge.
� Dipping provides the various interface measurement modes such as Find Product 

Interface, Find Water Interface, and Density Dipping features.
� Lock Test allows the displacer position to be locked at a defined level.
� Verify Calibration checks the calibration accuracy of the gauge.
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13.3.1 Gauge Items

NXA83_Gauge-Command_Gauge-Items_Feedback

This feature applies to Enraf and Motherwell gauges only.

The use of this feature requires a reasonable knowledge of gauging equipment and it is 
recommended that it is used by competent persons only.

This feature allows the user to read/write any of the gauge configuration items. To read an 
item, enter the item code and click on Execute, the response will be displayed at the bottom 
of the window. To write to an item, enter the item code, the data value to be written, and 
click on the Execute button.

Enraf Gauge Items

This feature supports the conversion units from those displayed in the Multi Scan NXA83 to 
units the gauge is configured to understand. In order to avoid confusion between the format 
used for settings made via a Portable Enraf Terminal (PET) and those of the Multi Scan 
NXA83 we recommend that you alter the units to match those used by the gauge.

To read a Gauge Item the Gauge Item Data field should be left blank. The data will be 
converted to the currently selected units before being displayed.

When setting Gauge Items, the user must enter the data value in the exact format which is 
appropriate for the selected Dimensions/Units, with +/- sign and appropriate number of 
digits before and after the decimal point. If unsure of the correct format, read the current 
value of the desired Item from the gauge first. The response from the gauge will be displayed 
in the format appropriate to the Dimensions/Units in use. Use the same format to set the 
Gauge Item Data to the desired new value.
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The following Dimensions/Units formats are supported:

Level

Temperature

Density

Pressure

All other Items use fixed formats that are unaffected by the Dimensions/Units selected by 
the user. Consult gauge manufacturer’s documentation for details.

Motherwell Gauge Items

Motherwell gauge items do not have the same unit conversion facility applied to them. The 
data entered into the Gauge Item Data field is transmitted verbatim to the gauge. You should 
consult your Motherwell documentation to determine the precise format of the data.

Key Designation

± sign: character (+/–)

N numeric digit

. decimal point

Units Format

mm ± N N N N N N. N (default)

M ± N N N . N N N N

Ft ± N N N N . N N N

In ± N N N N N . N N

f-i-s ± N N ' N N " N N

Units Format

° C ± N N N . N N (default)

° F ± N N N . N N

Units Format

kg/l ± N N . N N N N N (default)

kg/m3 ± N N N N N . N N

lb/ft3 ± N N N . N N N N

° API ± N N N N . N N N

Units Format

Bar ± N N . N N N N N (default)

Pa ± N N N N N N . N

kPa ± N N N N . N N N

lb/in2 ± N N N . N N N N
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With Motherwell gauges you can either specify a 2 digit hexadecimal item code, as described 
in the Motherwell gauge documentation or you can use a "shorthand" code for certain data 
items.

13.3.2 Maintenance

NXA83_Gauge-Command_Maintenance

If a gauge level reading differs from an operator's manual dip it is normal to re-align the 
gauge to the operator's dip.
This item is used to reset the reference level following a level dip.

The user must provide the new level dip and the level 2 password to access the gauge.
Select the tank (and gauge duty if necessary) requiring the new level dip.
Enter the Gauge password and New Gauge Dip level.
Click on the Dip button.

This command uses the following sequence of Gauge Item instructions:

Enter the level 2 password using W2 gauge item.

Set the reference level using the RL gauge item.

Shorthand Code Description

UR Upper Reference Level

RL Reference Level

HH High High Alarm Level

HA High Alarm Level

LA Low Alarm Level

LL Low Low Alarm Level
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Accept the reference level using the AR gauge item.

Exit and re-initialize the gauge using the EX gauge item.

The status of each item is displayed as it is processed.

When the EX command is issued the gauge will re-initialize. Gauge data may disappear for 
a short time during this process. After re-initialization the gauge level will read the new 
value.

13.3.3 Dipping

NXA83_Gauge-Command_Dipping

These generally apply to the Enraf 854 series of servo operated tank gauges.

Product Measurement Mode
This instruction sends the I1 Gauge Item and will cause the displacer to travel to the I1 
interface (Product level by default).
The gauge status is displayed throughout the process.
The gauge will remain at I1 until the user commands the gauge otherwise.

Density Dip – Tank Profile
Selecting this option will perform a 10 position density scan. This will start at the product 
level and end at the DZ Item position (0.30M by default).

Density Dip - Interface Profile
Selecting this option will perform a 10 position density scan over a reduced range, defined 
by the user. This is useful for density profiles around product interfaces e.g. Water interface.

4.
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Water Measurement Mode
This instruction sends the I3 Gauge Item and will cause the displacer to travel to the I3 
interface (Water level by default).
The gauge status is displayed throughout the process.
The gauge will remain at I3 until the user commands the gauge otherwise.

13.3.4 Lock Test

NXA83_Gauge-Command_Lock-Test

This command uses the MZ item to set the lock level, followed by the LT command to lock 
the displacer at the level specified by the user.

The user must provide the level at which the displacer will be locked and click on the Lock 
button.

If the Auto Unlock box is ticked the lock will release after 10 seconds and the displacer will 
return to product level.

If the Auto Unlock box not is ticked the displacer will remain in the locked position until 
commanded otherwise by the user.

Click on the Unlock button to unlock the displacer.
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13.3.5 Verify Calibration

NXA83_Gauge-Command_Verify-Calibration

This command performs a calibration test by using the CA item to move the displacer to the 
gauge Calibration Plate and comparing this level with the known Tank Top level. If the 
difference is greater than 2.5 mm, the verification fails.

The displacer will remain at the calibration plate until commanded otherwise by the 
operator.

The displacer start position is stored and displayed on the screen and the gauge status is 
reported at the bottom of the window.

To cancel calibration mode and return the displacer to Product Measurement Mode click on 
the Unlock button. 
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13.4 Scientific Instruments Gauge Commands

The 6290 densitometer gauge from Scientific Instruments supports a wide range of 
diagnostic and configuration parameters.

The parameters are grouped together into a number of pages, these being:
� System Settings
� Current Mode
� Current Status
� Current Data
� Profile Configuration
� Alarm Configuration
� Drive Configuration
� Sensor Configuration
� Sensor Calibration
� Host Configuration
� Host 1 Modbus Scaling
� Host 2 Modbus Scaling
� Diagnostics

The data displayed in a page is automatically retrieved from the gauge when it is opened. 
Therefore all data is considered live.

The meanings of the data parameters in the pages are not described in this document. For 
more information on these parameters, refer to the appropriate Scientific Instruments 
manual.

13.4.1 Page Selection

To display the parameters on any page, select that page from the list.

NXA83_Gauge-Command_Drice-Configuration

The parameters will initially be displayed with a value of ?? until the data is returned from 
the gauge.
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NXA83_Gauge-Command_Drive-Configuration_Values

13.4.2 Editing a Parameter

To edit a parameter on a page, double click on the parameter.

NXA83_Gauge-Command_Update-Item

Enter the new parameter in the dialog, and then click on Set.



Gauge Commands and Remote Configuration Tankvision

124 Endress+Hauser

A confirmation screen will be displayed. Click Yes to write the data to the gauge.

NXA83_Gauge-Command_Confirm-Action

If the confirmation screen is not required, tick the Do not show this page again option. This 
will only last until the Gauge Commands utility is closed.

The parameter will be shown as Waiting for Answer until the new data has been written to 
the gauge and read back, after which the new value will be displayed in the page. 

Many of the parameters are read-only. These have a code that starts with the character "R". 
Any attempt to write to one of these will result in the following message being displayed.

NXA83_Gauge-Command_not-valid

(e.g. Instant Bottom Stop, item code R8)

13.4.3 Auto Refresh

To set a page to auto refresh the data at periodic interval, set the field Auto Update Screen 
Every to the interval period required, and then click on the Start button.

The data will now be refreshed at the rate specified. If the Auto Update period is set too low, 
the page will be continually refreshing, during which time the Waiting for Answer may be 
displayed. A refresh period of 10 seconds is the lowest value recommended, with 30 seconds 
as the more normal value.

13.4.4 Saving the data to file

The full set of data parameters may be updated and saved to an XML format file. This may 
then be printed or sent to SI for investigation if problems occur with the gauge.

The file will always be saved to the Logs sub-directory of the install directory.

To save the data, click on the page Save To File.
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NXA83_Gauge-Command_Save-to-File

Select the File Name in the Logs directory, and then click on the Execute button. All the data 
for all pages will now be automatically retrieved from the gauge. This may take some time, 
during which a progress bar will be displayed.

NXA83_Gauge-Command_Updating-Data

When complete, click OK. The data saved in the file will be formatted and displayed on the 
screen.
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NXA83_Gauge-Command_Save-to-File_Complete

Previously saved files may be viewed by selecting the File Name and clicking on the View 
button.
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14 Technical Specification

Property Specification

CPU AMD Geode LX2 500 Mhz , Fanless

Memory 512 MB

Disk
2 GB Compact Flash Disk as C drive
1 GB Disk On Module as D drive

Operating System Windows XP embedded

Display 7 in Widescreen module

Resolution 640 by 480

Keyboard Input 4–wire Touch screen connected to USB port

Standard Serial 8 COM ports

USB
4 ports, USB 2.0 Compliant
2 Internal / 2 External
1 Internal port is used for the touchscreen

Ethernet 1 port , 10/100 Mhz

Power Supply 110 to 240 Vac

Power Consumption 40 W

IP Rating IP20

Operating Temperature 0 to 40 °C (+32 to +104 °F)

Storage Temperature 0 to 85 °C (+32 to +185 °F)

External Dimensions
Wall Mount: 323 mm × 300 mm × 101.5 mm (12.7 in × 11.8 in × 4 in)
Rack Mount: 482.6 mm × 117 mm × 255 mm (19 in × 4.61 in × 10 in)

Mounting To suit M6 bolts, four positions

Weight 2 kg (4.41 lbs)

Approvals CE
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15 Troubleshooting
The following are some fail modes that may occur during commissioning:

Gauge(s) are displayed with all data DN00 and the "No reply from gauge" alarm is set.
� Check that the data loop is connected to the correct port on the Multi Scan NXA83 and that 

the wiring is correct.
� Check that the COM port has been configured with the correct protocol and 

communication parameters (baud rate, parity etc.).
� Check the gauge configuration for the correct gauge addresses and other gauge specific 

communication parameters.
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